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Neste guia…
Este guia contém as informações para se aprender a usar o seu Agilent 
MassHunter Workstation Software - Análise Qualitativa  com dados do CG/MS. 

Antes de começar a fazer os exercícios, por favor, leia as instruções em “Antes 
de começar com estes exercícios...” na página 5.

Exercise 1 Aprenda noções de análise qualitativa

Neste exercício, você explorará algumas das muitas poderosas funções do 
programa de Análise Qualitativa. Estas tarefas são importantes, não importa 
que tipo de dados você está usando.

Exercise 2 Encontre e Identifique

Nos dois primeiros conjuntos de tarefas, você localiza e identifica 
medicamentos com baixa concentração de sulfa dentro de uma matriz 
complexa e gera suas fórmulas para os dados TOF e Q-TOF. Também é possível 
fazer uma extração de recurso molecular em uma digestão de proteína com os 
dados TOF e Q-TOF. Estas tarefas também podem ser executadas nos dados 
Triple Quad.

Exercise 3 Utilize fluxos de trabalho, exporte e imprima

Nestas tarefas, você aprende a configurar a executar qualquer método de 
análise quantitativa. Você também aprende a editar um método para 
automatizar a análise e/ou identificação do composto. Depois, você executa as 
ações dentro do método automatizando quando abre um arquivo de dados. 
Você também aprende a criar um método para executar ações automatizadas 
com uma lista de trabalho. Cada uma destas tarefas é executada usando um 
fluxo de trabalho diferente.

Referência

Neste capítulo, você aprenderá noções básicas do programa de Análise 
Qualitativa.
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O Que é Novo

no B.06.00

• Você pode revisar compostos na Visualização de Detalhes do Composto. 
Quatro janelas adicionais estão disponíveis na Visualização de Detalhes do 
Composto.

• Quanto à Visualização de Detalhes do Composto, você pode definir diferentes 
configurações de linha para diferentes tipos de cromatógrafos e espectros.

• O algoritmo Encontrar Compostos por Integração está disponível.

• Você pode procurar em múltiplas bibliotecas por meio do algoritmo de 
busca de biblioteca e massa de unidade.

• No algoritmo Gerar Fórmulas, você pode selecionar se quer anotar os picos 
de espectro do fragmento com as fórmulas. A anotação do fragmento 
seleciona o espectro a ser anotado com base no algoritmo de minagem de 
composto.

• O algoritmo Gerar Fórmulas pode ser executado em compostos que você 
encontra por meio do algoritmo Encontrar pela Deconvolução do 
Cromatógrafo.

• O algoritmo Gerar Fórmula foi modificado para permitir que você insira 
um número máximo de batidas para cada carregador de carga.

• No algoritmo Gerar Fórmulas, você pode agrupar batidas com a mesma 
fórmula, mas com carregadores de carga distintos.

• Os compostos podem ser criados a partir de qualquer espectro de usuário. 
O algoritmo de minagem de compostos para estes compostos é “Extração 
de Espectro”.

• Quando você estiver salvando resultados com seu arquivo de dados, você 
pode selecionar se deseja salvar os resultados de todos os compostos com o 
arquivo de dados ou com um conjunto menor de resultados para cada 
composto. Todos os cromatogramas de usuário e espectros de usuário são 
sempre salvos.

• O formato do arquivo CEF foi modificado, de modo que mais informação é 
incluída.

• O m/z e a informação de espécie de íon estão disponíveis no primeiro nível 
da tabela de Resultados de Identificação de Espectro.

• A tabela de Identificação de Espectro foi modificada. Você pode adicionar 
um filtro para uma coluna, e você pode excluir uma fila.
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• Você pode agora classificar um pico com Fórmula & Espécie de Íon.

• Alterar o espectro classificado como Melhor na janela Resultados de 
Identificação de Espectro, quando você tiver um número grande de 
entradas, é agora um processo significativamente mais rápido.

• Você pode especificar que os cromatogramas de camada sejam sobrepostos 
no Relatório de Composto.

• O template de relatório da Confirmação de Fórmula padrão foi modificado 
para incluir a coluna colorida de Marcações (tgt) e a Tabela de Fragmentos 
com a coluna colorida de Marcações (tgt).

Antes de começar com estes exercícios...
• Instale o software. Consulte o Guia de Instalação para instruções.

• Copie as pastas nomeadas Dados de seu disco de instalação em formato 
descomprimido para qualquer local em seu disco rígido. 

Esta pasta contém todos os arquivos de dados necessários para este 
exercício. Você pode precisar primeiro extrair os arquivos de dados de seu 
formato .zip.

NOTA Não reutilize os arquivos de dados de exemplo que já estão em seu sistema, a menos que 
você saiba que você os copiou dos originais no disco e que você é a única pessoa a 
utilizá-los. Se os arquivos de dados de exemplo já estão no sistema não coincidem com os 
originais exatos no disco, então os resultados obtidos durante este exercício não 
coincidirão com aqueles fornecidos no guia.
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Neste exercício, você explorará algumas das muitas potencialidades do 
programa Qualitative Analysis para trabalhar com dados GC/Q-TOF e 
GC/QQQ.

Cada exercício é apresentado em uma tabela com três colunas:

• Passos – Use instruções gerais para proceder por conta própria, explorando 
o programa.

• Instruções Detalhadas – Utilize-as se você precisar de ajuda ou se preferir 
um processo de aprendizado passo-a-passo.

• Comentário – Leia-os para obter dicas e informação adicional sobre cada 
passo no exercício.
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1 Aprenda noções de análise qualitativa
Abra o programa Qualitative Analysis
Abra o programa Qualitative Analysis

Nesta tarefa, você abre múltiplos arquivos de dados utilizando o método atual. 

 

Tarefa 1. Abra o programa Qualitative Analysis com múltiplos arquivos de dados

Etapas Instruções Detalhadas Comentários

1 Abra o programa Qualitative 
Analysis. 
• Abra os arquivos de dados Pest - 

200 - Scan.d, Pest - STD 200 
MRM.d, Pest Strawb-01 
SPIKED 1 ppb - 1 ul inj.d e 
MSD_mix_4stds_DG_spl200_0
3.d na pasta 
\\MassHunter\Data ou na 
pasta para a qual você os copiou.

a Clique duas vezes sobre o ícone 
Agilent MassHunter Qualitative 
Analysis B.06.00 . 
O sistema exibe a caixa de diálogo 
Open Data Files.

b Vá para a pasta \\MassHunter\
Data\GC ou para a pasta onde os 
arquivos-exemplo estão localizadas.

• O arquivo Pest - 200 - Scan.d 
contém dados MS e o Pest - STD 
200 MRM.d e os arquivos Pest 
Strawb-01 SPIKED 1 ppb - 1 ul inj.d 
contêm tanto dados MS quanto 
MS/MS (todos GC/QQQ). 
MSD_mix_4stds_DG_spl200_03.d 
contém dados GC/Q-TOF.

• Você pode obter ajuda para a maior 
parte das janelas, caixas de diálogo 
e abas pressionando a tecla F1 
quando o teclado estiver ativo.

• Tenha certeza de que o botão 
Use current method foi clicado.

• Tenha certeza de que a caixa de 
marcação Load result data está 
limpa. Se a caixa de marcação 
Load result data não estiver 
disponível, então nenhum 
resultado foi salvo no arquivo de 
dados. Você aprende a salvar 
resultados em “Tarefa 17. Salvar 
resultados” na página 69 para 
instruções sobre como salvar 
resultados.

• Tenha certeza de que a caixa de 
marcação Run ‘File Open’ 
actions from selected method 
está limpa.

Figura 1 Abra arquivos de dados quando abrir o software
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Aprenda noções de análise qualitativa 1
Abra o programa Qualitative Analysis
c Pressione e segure a tecla Shift 
quando você clicar em Pest - 200 - 
Scan.d, Pest - STD 200 MRM.d, Pest 
Strawb-01 SPIKED 1 ppb - 1 ul inj.d e 
MSD_mix_4stds_DB_spl200_03.d.

d Clique em Open.
Todos os quator arquivos de dados 
são exibidos na janela Data Navigator, 
e de 1 a 3 cromatogramas são exibidos 
na janela Chromatogram Results.

e Clique no ícone List Mode  na 
barra de ferramentas 
Chromatogram Results.

• Se você pressionar a tecla Ctrl, você 
pode escolher arquivos que não 
estão diretamente próximas uns 
aos outros na lista.

• O que você vê na janela principal, 
neste momento, depende do 
método, layout, exibição e 
configurações de plot que você 
utilizou antes de abrir estes 
arquivos.

• Quando você clica sobre o ícone 
List Moe, o plano de fundo do ícone 
muda para laranja.

Tarefa 1. Abra o programa Qualitative Analysis com múltiplos arquivos de dados (cont.)

Etapas Instruções Detalhadas Comentários
Agilent MassHunter Workstation Software - Análise Qualitativa Guia de Familiarização para GC/MS 11



1 Aprenda noções de análise qualitativa
Abra o programa Qualitative Analysis
Figura 2 A janela principal da Qualitative Analysis com o GC/Q-TOF Compound Screening Workflow 
é carregada. 

Tarefa 1. Abra o programa Qualitative Analysis com múltiplos arquivos de dados (cont.)

Etapas Instruções Detalhadas Comentários

Ícone Maximum 
Number of List Panes

Ícone Display 
Options

Clique no botão X para 
fechar esta janela.
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Aprenda noções de análise qualitativa 1
Tarefa 2. Configurar Interface de Usuário para dados GC/MS
Tarefa 2. Configurar Interface de Usuário para dados GC/MS

Nesta tarefa, você alterna ou para o fluxo Geral (para clientes GC/QQQ) ou 
para o fluxo de trabalho GC/Q-TOF Compound Screening (para clientes 
GC/Q-TOF). Estes dois fluxos de trabalho são os únicos que aceitam a análise 
de dados GC/MS. Em seguida, abra a caixa de diálogo User Interface 
Configuration e marque as caixas de marcação apropriadas para um sistema 
GC/QQQ ou um sistema GC/Q-TOF.

Tarefa 2. Configurar Interface de Usuário para GC

Etapas Instruções Detalhadas Comentários

1 Se necessário, abra o programa 
Qualitative Analysis 

a Clique duas vezes sobre o ícone 
Agilent MassHunter Qualitative 
Analysis . 
O sistema exibe a caixa de diálogo 
Open Data Files.

b Clique sobre Cancel na caixa de 
diálogo Open Data Files.

• Você pode obter ajuda para a maior 
parte das janelas, caixas de diálogo 
e abas pressionando a tecla F1 
quando a janela estiver aberta.

2 Alterne ou para General Workflow, 
ou para GC/Q-TOF Compound 
Screening Workflow.

a Se você tiver um instrumento 
GC/QQQ, clique sobre o comando 
Configuration > Configure for 
Workflow > General. Se você tiver um 
instrumento GC/Q-TOF, clique sobre o 
comando Configuration > Configure 
for Workflow > GC/Q-TOF Compound 
Screening.

b Clique no botão Load workflow’s 
default method e no botão Load 
workflow’s default layout.

c Clique em OK.
d Clique no ícone List Mode  na 

barra de ferramentas Chromatogram 
Results.

• Se o programa Data Acquisition 
para GC/QQQ ou GC/Q-TOF está 
instalado no mesmo computador, o 
software configura a Interface de 
Usuário automaticamente. A seção 
GC/Q-TOF Compound Screening 
pode já estar disponível na janela 
Method Explorer.

• Por definição, os cromatogramas 
estão sobrepostos. Para estes 
exemplos, os cromatogramas são 
exibidos em List Mode.
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1 Aprenda noções de análise qualitativa
Tarefa 2. Configurar Interface de Usuário para dados GC/MS
3 Se você tem um GC/QQQ, 
configure a interface do usuário 
para exibir as funções GC/QQQ 
apenas.

a Clique em Configuration > User 
Interface Configuration.

b Em Separation types, marque apenas a 
caixa de marcação GC.

c Se você tem um instrumento GC/QQQ, 
então, em tipo de ionização, marque a 
caixa de marcação EI or other “hard” 
ionization technique e limpe a caixa 
de marcação CI, APCI, ESI, MADLDI or 
other “soft” ionization technique.

d Sob Mass accuracy, limpe a caixa de 
marcação Accurate mass (TOF, 
Q-TOF). Marque as caixas de 
marcação Unit mass (Q, QQQ).

e Em Optional software features, limpe a 
caixa de marcação Peptide Sequence 
Editor e a caixa de marcação 
BioConfirm Software.

f Sob Non-MS detectors, limpe as 
caixas de marcação UV and ADC.

g Marque a caixa de marcação Show 
advanced parameters.

h Clique em OK.

• Você pode alterar quais comandos 
estão disponíveis na caixa de 
diálogo User Interface 
Configuration. 

• Se uma função não estiver visível, 
então provavelmente ela está 
escondida quando uma caixa de 
marcação User Interface 
Configuration.

Figura 3 Configurando a interface de usuário para usá-la com dados GC/QQQ.

Tarefa 2. Configurar Interface de Usuário para GC

Etapas Instruções Detalhadas Comentários
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Aprenda noções de análise qualitativa 1
Tarefa 2. Configurar Interface de Usuário para dados GC/MS
4 Se você tem um instrumento 
GC/Q-TOF, configure a interface do 
usuário para exibir funções 
GC/Q-TOF apenas.

a Clique em Configuration > User 
Interface Configuration.

b Em Separation types, marque apenas a 
caixa de marcação GC.

c Em tipo de ionização, marque ambas 
as caixas de marcação.

d Em MS levels, marque ambas as 
caixas de marcação.

e Sob Mass accuracy, limpe a caixa de 
marcação Accurate mass (TOF, 
Q-TOF). Limpe as caixas de marcação 
Unit mass (Q, QQQ).

f Em Optional software features, limpe a 
caixa de marcação Peptide Sequence 
Editor e a caixa de marcação 
BioConfirm Software.

g Sob Non-MS detectors, limpe as 
caixas de marcação UV and ADC.

h Marque a caixa de marcação Show 
advanced parameters.

i Clique em OK.

• Você pode alterar quais comandos 
estão disponíveis na caixa de 
diálogo User Interface 
Configuration. 

• Se uma função não estiver visível, 
então provavelmente ela está 
escondida quando uma caixa de 
marcação User Interface 
Configuration.

Figura 4 Configurando a interface de usuário para GC/Q-TOF.

Tarefa 2. Configurar Interface de Usuário para GC

Etapas Instruções Detalhadas Comentários
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1 Aprenda noções de análise qualitativa
Tarefa 3. Ampliar ou reduzir a visualização do cromatograma
Tarefa 3. Ampliar ou reduzir a visualização do cromatograma

Nesta tarefa, você se familiarizará com as funções de aumentar ou diminuir 
zoom do programa Qualitative Analysis.
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Aprenda noções de análise qualitativa 1
Tarefa 4. Fixar um cromatograma
Tarefa 4. Fixar um cromatograma

Nesta tarefa, você fixará um cromatograma. Quando você fixa um 
cromatograma, o cromatograma fixo permanece constantemente em exibição 
enquanto você navega pelos outros cromatogramas para exibi-los.

Tarefa 4. Fixar um cromatograma

Etapas Instruções Detalhadas Comentários

• Fixar um cromatograma
• Exibir todos os cromatogramas
• Tenha certeza de que a lista de 

visualização de cromatograma 
está definida para 1.

• Na janela Chromatogram 
Results, selecione o segundo 
TIC.

• Fixe este TIC.
• Navegue pelos cromatogramas.
• Limpar a fixação

a Em Data Navigator, marque as caixas 
de marcação para os cromatogramas 
que você escondeu na tarefa anterior.

b Tenha certeza de que o número 
máximo de painéis está definido como 
1 na janela Chromatogram Results.

c Na janela Chromatogram Results, 
selecione o segundo TIC.

d Clique com o botão direito no 
cromatograma, em seguida, clique em 
Set Anchor.

e Utilize a barra de rolagem na janela 
Chromatogram Results para navegar 
pela lista de cromatogramas. O 
segundo TIC permanece sempre 
visível, como o primeiro 
cromatograma. 

f Clique em Chromatograms > Clear 
Anchor.

• Quando você define uma fixagem 
para um cromatograma, um ícone 
de fixagem aparece na janela do 
Data Navigator, próximo ao nome 
do cromatograma fixo.

• Dois cromatogramas aparecem na 
janela Chromatogram Results após 
você fixar um, mesmo que a lista de 
visualização indique 1. Isto 
significa, agora, que você visualiza 
um cromatograma adicional ao 
cromatograma fixo.

• Você pode também clicar com o 
botão direito e clicar Clear Anchor 
no menu do atalho.

Figura 5 TIC fixo na janela Chromatogram Results
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1 Aprenda noções de análise qualitativa
Tarefa 5. Modificar layouts de janela
Tarefa 5. Modificar layouts de janela

Nesta tarefa, você move as janelas na visualização principal e cria vários 
layouts de janelas.

Tarefa 5. Modificar layouts de janela

Etapas Instruções Detalhadas Comentários

1 Modifique o layout de janela:
• Modifique o tamanho da janela.
• Salve o layout da janela.
• Desbloqueie o layout.
• Modifique a janela 

Chromatogram Results para que 
ela flutue.

• Mova a janeal Chromatogram 
Results.

• Exiba as ferramentas para o 
reposicionamento das janelas.

• Para modificar o tamanho de uma 
janela, arraste a fronteira entre janelas.

• Para salvar um layout de janela, clique 
em Configuration > Window 
Layouts > Save Layout.

• Para desbloquear um layout de janela, 
clique em Configuration > Window 
Layouts > Lock Layout. 

• Para fazer uma janela flutuar, clique 
com o botão direito sobre a janela, em 
seguida, clique em Floating no menu 
de atalhos.

• Para mover uma janela, clique na barra 
de título da janela e arraste-a para o 
local desejado. 

• Para exibir as ferramentas de 
reposicionamento, arraste a janela 
sobre uma das outras janelas. Quando 
a janela estiver sobrepondo uma 
segunda, o programa exibirá várias 
ferramentas de layout, como exibidas 
em Figura 6.

• Se o layout estiver desbloqueado, o 
sistema não exibirá uma marca de 
checagem ao lado do menu Lock 
Layout.

• Você pode usar apenas as 
ferramentas de reposicionamento 
quando o layout estiver 
desbloqueado.

• Você também pode fazer uma janela 
flutuar clicando duas vezes sobre a 
barra título da janela.

• O software tem muitos layouts 
diferentes criados. Você também 
pode tentar criar layouts diferentes.

• O software tem diferentes fluxos de 
trabalho. Cada fluxo de trabalho 
carrega um layout diferente. Alterar 
para um fluxo de trabalho diferente 
também modifica o layout.

Figura 6 Ferramentas de reposicionamento de janela.
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2 Reposicionamento na janela 
Chromatogram Results.
• Mova a janela de modo que ela 

permaneça ao topo, à esquerda, 
à direita e, em seguida, na parte 
inferior da janela.

• Mova duas janelas 
conjuntamente de modo que 
uma esteja ao topo da outra e 
disponível apenas por meio de 
abas na parte inferior. 

• Recupere o layout padrão.

• Se você arrastar o cursor sobre um dos 
ícones menores, a janel que você está 
arrastando será posicionada acima, à 
direita, abaixo ou à esquerda de todas 
as outras janelas. 

• Arraste o cursor sobre o ícone maior. 
A janela pode também ser posicionada 
acima, à direita, abaixo ou à esquerda 
de uma outra janela arrastando o 
cursor sobre as bordas de um ícone 
maior.

• Para agrupar duas janelas juntas, 
arraste o cursor sobre o centro do 
ícone maior. Você verá uma versão 
sombreada das duas janelas 
agrupadas. Pare de arrastar o mouse. 
AS duas janelas serão colocadas 
conjuntamente em abas.

• Clique em Configuration > Window 
Layouts > Restore Default Layout.

• O cursor deve estar sobre uma das 
setas em uma caixa, para que o 
reposicionamento aconteça.

• Clicar sobre o comando Restore 
Default Layout restaura o layout 
que é utilizando pelo fluxo de 
trabalho General e pelo fluxo de 
trabalho GC/Q-TOF Compound 
Screening. Se você está usando um 
fluxo de trabalho diferente, você 
precisa carregar o layout que é 
usado para este fluxo de trabalho.

Tarefa 5. Modificar layouts de janela (cont.)

Etapas Instruções Detalhadas Comentários
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Tarefa 6. Extrair cromatogramas

Nesta tarefa, você extrai e funde os cromatogramas do TIC original. 

Tarefa 6. Extrair cromatogramas

Etapas Instruções Detalhadas Comentários

1 Extraia e funda os cromatogramas 
de íon extraídos (EICs) de duas 
massas no arquivo de dados Pest - 
200 Scan.d.
• Os valores m/z são 129.0 e 

414.2.
• Não funda os picos de massas 

individuais em um 
cromatograma.

a Na janela Data Navigator, limpe as 
caixas de marcação dos arquivso de 
dados exceto por Pest - 200 Scan.d.

b Abra a caixa de diálogo Extract 
Chromatograms, usando a opção 
abaixo ou uma das opções à direita: 
• Clique em Chromatograms > 

Extract Chromatograms.
c Em List of opened data files, clique em 

Pest - 200 - Scan.d.
d Na caixa de lista Type, selecione EIC.
e No campo m/z value(s), digite 
129.0, 414.2

f Se necessário, limpe a caixa de 
checagem Merge multiple masses 
into one chromatogram para fundir os 
EICs.

g Clique em OK.
h Defina Maximum number of list 

panes para 3 na barra de ferramentas 
Chromatogram Results.

• Você pode também extrair 
cromatogramas de uma das 
seguintes maneiras:
• Clique com o botão direito no 

cromatograma e clique em 
Extract Chromatograms.

• Partindo de Data Navigator, 
selecione TIC Scan para 
sulfas_PosMS.d, em seguida, 
clique com o botão direito sobre 
TIC Scan e clique em Extract 
Chromatograms.

• Você pode utilizar o nível do MS ou 
All ou MS.

• Observe que você também pode 
escolher fazer com que o 
cromatograma extraído 
automaticamente seja integrado 
após a extração.

• Você também pode extrair um 
cromatograma partindo de um 
espectro de massa.

Figura 7 A caixa de diálogo Extract Chromatograms
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Figura 8 Cromatogramas de íon extraídos fundidos (EICs) comparados 
ao TIC original

Tarefa 6. Extrair cromatogramas (cont.)

Etapas Instruções Detalhadas Comentários
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Tarefa 7. Integre interativamente um cromatograma GC/MS

Nesta tarefa, você aprende modos diferentes de se integrar um cromatograma, 
altere os parâmetros de integração para modificar os resultados e calcular a 
relação Sinal-Ruído para os picos integrados para dados MS/MS.

Tarefa 7. Integre interativamente um cromatograma GC/MS

Etapas Instruções Detalhadas Comentários

1 Integre o arquivo de dados TIC 
Scan chromatogram for the Pest - 
200 - Scan.d, utilizando qualquer 
uma das opções listadas abaixo.

a Marque o arquivo de dados Pest - 200 - 
Scan.D na janela Data Navigator.

b Selecione o cromatograma TIC Scan e 
utilize um dos seguintes comandos:
• A partir da barra de menu, clique em 

Chromatograms > Integrate 
Chromatogram.

• Clique com o botão direito em 
qualquer lugar na janela de 
cromatograma, e clique em 
Integrate Chromatogram.

• Na janela Data Navigator, selecione 
Pest - 200 - Scan.D > User 
Chromatograms > TIC Scan, em 
seguida, clique com o botão direito 
em TIS Scan e clique em Integrate 
Chromatogram.

• Observe que o programa integrou 
praticamente todos os picos no 
cromatograma.

• Selecione o integrador a ser usado 
para os dados de MS, dados de 
MS/MS e dados de GC na janela 
Method Editor.

• O cromatograma é um 
cromatograma MS, de modo que os 
valores que são definidos na seção 
Integrate (MS) do Method Editor 
são usados quando se integra o 
cromatograma.

2 Exiba apenas dois cromatogramas 
ao mesmo tempo.

• Selecione 2 da caixa Maximum 
number of list panes na barra de 
ferramentas Chromatogram Results.

Figura 9 TIC Scan Chromatogram integrado com muitos picos pequenos.

Muitos picos pequenos são 
integrados.
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3 Modifique o limite para integrar 
picos menores.
• Modifique o limite para reter 

apenas três picos maiores.

a A partir da janela Method Explorer, 
clique Chromatogram > Integrate 
(MS) para exibir a aba Integrate (MS).

b Selecione o integrador Agile.
c Clique na aba Peak Filters.
d Sob Maximum number of peaks, 

marque Limit (by height) to the 
largest, e digite 3.

• Observe o triângulo azul que 
aparece quando você modifica a 
configuração do valor salvo para o 
método atual. Quando você salvar o 
método, os triângulos 
desaparecem.

Figura 10 Aba Peak Filters com Limit (by height) to the largest 
marcado.

4 Reintegrar o cromatograma e Clique sobre o botão  na barra de 
ferramentas do Method Editor para 
integrá-lo utilizando a nova 
configuração.

• Observe que apenas os três 
principais picos estão agora 
integrados.

• O pico em 2.491 tem uma altura 
superior ao pico em 16.858 minutos, 
de modo que o pico selecionado é o 
terceiro.

Tarefa 7. Integre interativamente um cromatograma GC/MS (cont.)

Etapas Instruções Detalhadas Comentários
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Figura 11 O cromatograma integrado TIC Scan quando se limita o número de picos.

5 Integrar o cromatograma TIC MRM 
para o arquivo de dados Pest - STD 
200 MRM.D.

a Na janela Data Navigator, selecione 
TIC MRM para o arquivo de dados 
Pest - STD 200 MRM.d. 

b Utilize um dos seguintes comandos 
para integrar os cromatogramas.
• A partir da barra de menu, clique em 

Chromatograms > Integrate 
Chromatogram.

• Clique com o botão direito em 
qualquer lugar na janela de 
cromatograma, e clique em 
Integrate Chromatogram.

• Na janela Data Navigator, clique 
com o botão direito no 
cromatograma destacado e clique 
em Integrate Chromatogram.

c Aumente a visualização de 5.8 para 
8.5 minutos.

d Defina o Maximum number of list 
panes para 2.

• Pressione a tecla Ctrl para destacar 
mais do que um cromatograma na 
janela Data Navigator.

• Observe que o programa integrou 
praticamente todos os picos no 
cromatograma.

• Estes cromatogramas são 
cromatogramas MS/MS, portanto, 
os valores que são definidos na 
seção Integrate (MS/MS) da janela 
Method Editor são usadas quando 
se utiliza a integração do 
cromatograma. Você pode 
selecionar um integrador a ser 
utilizado para se integrar os 
cromatogramas MS e um integrador 
diferente, para ser usado na 
integração dos cromatogramas 
MS/MS.

Tarefa 7. Integre interativamente um cromatograma GC/MS (cont.)

Etapas Instruções Detalhadas Comentários
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Figura 12 Cromatogramas MRM integrados 

6 Selecione o integrador MS/MS 
(GC). Modifique o filtro para 
aceitar apenas picos com uma 
altura absoluta maior ou igual a 
20,000.

a Na janela do Method Explorer, 
selecione Chromatogram > Integrate 
(MS/MS).

b Selecione MS/MS (GC) como 
Integrator.

c Clique na aba Peak Filters.
d Sob Filter on, clique em Peak height.
e Sob Height filters, marque a caixa de 

seleção Absolute height.
f Digite 60000 como Absolute height.

• Observe o triângulo azul que 
aparece quando você modifica a 
configuração do valor salvo para o 
método atual. Quando você salvar o 
método, os triângulos 
desaparecem.

Figura 13 Aba Peak Filters com Absolute height marcado

7 Reintegrar o cromatograma g Clique no botão  na barra de 
ferramentas Method Editor.

• Observe que apenas os picos 
maiores estão agora integrados.

Tarefa 7. Integre interativamente um cromatograma GC/MS (cont.)

Etapas Instruções Detalhadas Comentários
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Figura 14 Cromatogramas TIC e EIC MS/MS integrados com um limite mais alto. 

8 Restaure as configurações que 
estão salvas no método atual e 
feche o Method Editor.

a Selecione a seção Chromatogram > 
Integrate (MS/MS) no Method 
Explorer.

b Clique sobre o ícone  no Method 
Editor.

c Selecione a seção Chromatogram > 
Integrate (MS) no Method Explorer.

d Clique sobre o ícone  no Method 
Editor.

e Feche a janela Method Editor.

• Para cancelar suas modificações e 
restaurar os valores do método 
carregado, clique no ícone Restore 
to last saved values from file 
na barra de ferramentas 
Method Editor. 

9 Exclua todos os cromatogramas, 
exceto o original. Exclua os 
resultados da integração do 
cromatograma original.

a Sob User Chromatograms, na janela 
Data Navigator, selecione todos os 
cromatogramas, exceto o original.

b Clique com o botão direito sobre os 
cromatogramas, e clique em Delete.

c Selecione todos os cromatogramas 
TIC.

d Clique em Chromatograms >Clear 
Results.

• Quando você utilizar o comando 
Clear Results, os cromatogramas 
não serão excluídos; os resultados 
que são conectados aos 
cromatogramas serão removidos. 
Neste caso, os valores de 
integração serão limpos.

Tarefa 7. Integre interativamente um cromatograma GC/MS (cont.)

Etapas Instruções Detalhadas Comentários

O menor pico a 5.8 minutos não está 
incluído mais nos resultados de integração 
porque a altura absoluta para este pico é 
inferior a 6.000 contagens.
26 Agilent MassHunter Workstation Software - Análise Qualitativa Guia de Familiarização para GC/MS



Aprenda noções de análise qualitativa 1
Tarefa 8. Calcular valores do sistema de adaptação
Tarefa 8. Calcular valores do sistema de adaptação

Nesta tarefa, você aprende modos diferentes de se integrar um cromatograma, 
altere os parâmetros de integração para modificar os resultados e calcular a 
relação Sinal-Ruído para cada pico. Você também aprende como habilitar os 
cálculos do Sistema de Adaptação.

Tarefa 8. Integre interativamente um cromatograma (MS)

Etapas Instruções Detalhadas Comentários

1 Integre o cromatograma 
MSD_mix_4stds_DB_spl200_03.d 
e Pest - 200 - Scan.d utilizando 
qualquer uma das opções listadas 
à direita.

a Marque a caixa de marcação próxima 
aos arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d na 
janela Data Navigator.

b Marque as caixas de marcação 
próximas ao arquivo de dados Pest - 
200 - Scan.D na janela Data Navigator.

c Destaque ambos os TICs.
d Integre a TIC Scan para ambos os 

arquivos, utilizando qualquer uma das 
seguintes opções.
• A partir do menu principal, clique em 

Chromatograms > Integrate 
Chromatogram.

• Destaque o cromatograma. Em 
seguida, clique com o botão direito 
no cromatograma e clique em 
Integrate Chromatogram.

• No Data Navigator, destaque TIC 
Scan para ambos os arquivos de 
dados. Em seguida, clique com o 
botão direito sobre o cromatograma 
e clique em Integrate 
Chromatogram.

• Para o fluxo de trabalho Geral, a 
integração utiliza o General 
Integrator, porque este foi o 
integrador selecionado no método 
default.m. Para o fluxo de trabalho 
GC/Q-TOF Compound Screening, a 
integração utiliza o Agile Integrator. 

• Você pode modificar este valor na 
aba Chromatogram > Integrate 
(MS) > Integrator.

• Observe que a integração com 
parâmetros padrão detecta picos 
muito pequenos.
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Figura 15 Um dos menus de atalho no Data Navigator e os cromatogramas integrados

2 Habilitar cálculos de 
adaptabilidade do sistema para os 
cromatogramas do MS. 

a Em Method Explorer, clique 
Chromatogram > Integrate (MS) para 
exibir a aba Integrate.

b Clique na aba Suitability.
c Marque Enable system suitability 

calculations.
d Selecione United States 

Pharmacopoeia (USP).
e Na caixa Column void time, tipo 1.
f Na caixa Column length tipo 3000.

• Observe o triângulo azul que 
aparece quando você modifica a 
configuração do valor salvo para o 
método atual. Quando você salvar o 
método, os triângulos 
desaparecem.

• Os algoritmos que são usados para 
definir várias colunas na Integration 
Peak List mudam, dependendo da 
farmacopeia selecionada. Consulte 
a Ajuda online para mais 
informações.

Figura 16 Aba Chromatogram > Integrate (MS) Suitability

Tarefa 8. Integre interativamente um cromatograma (MS) (cont.)

Etapas Instruções Detalhadas Comentários

O tempo de espera da coluna e 
a espessura da coluna para 
estes arquivos de dados é 
diferente destes valores. Estes 
são usados apenas para este 
exemplo.
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3 Reintegrar o cromatograma. • Clique no ícone Integrate 
Chromatogram  na barra de 
ferramentas Method Editor para 
realizar a integração com a nova 
configuração.

4 Visualize os cálculos de 
adaptabilidade do sistema.
• Abra a janela Integration Peak 

List.
• Reveja os valroes para a região 

de ruído e calcule a razão 
sinal-ruído para picos 
integrados.

a Clique em View > Integration Peak 
List.

b Clique com o botão direito no 
cabeçalho da janela Peaks e clique em 
Floating.

c Clique com o botão direito no 
cabeçalho de qualquer coluna que 
você não queira ver e clique em 
Remove Column. 

d Clique com o botão direito em 
qualquer cabeçalho de coluna e clique 
em Add/Remove Columns para 
modificar as colunas visíveis.

• Os cálculos de adaptabilidade do 
sistema são incluídos na tabela 
Integration Peak List.

• Estes valores incluem k', Tailing 
factor, Plates, Plates/M e 
Symmetry.

• Você também pode habilitar os 
cálculos de adaptabilidade de 
sistema para um MS, um MS/MS e 
um cromatograma GC.

Figura 17 A tabela Integrated Peaks com valores de adaptabilidade do 
sistema.

5 Restaure as configurações para o 
método padrão e feche a janela 
Method Editor e a janela 
Integration Peak List.

a Para cancelar suas modificações e 
restaurar os valores do método padrão, 
clique no ícone Restore to last 
saved values from file  na barra 
de ferramentas Method Editor. 

b Feche a janela Method Editor.
c Clique com o botão direito no 

cabeçalho da janela Peak List e clique 
em Floating.

d Clique em View > Integration Peak 
List.

• Quando você clica no comando 
Floating no menu de atalhos pela 
segunda vez, a janela Integration 
Peak List volta para o local onde 
estava anteriormente.

Tarefa 8. Integre interativamente um cromatograma (MS) (cont.)

Etapas Instruções Detalhadas Comentários
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Tarefa 9. Extrair espectros de um cromatograma

Nesta tarefa, você extrai um espectro exatamente de onde você especificou no 
cromatograma. O programa Qualitative Analysis extrai um espectro de um 
ponto de dados específico ou extrai um espectro médio de uma média de 
múltiplos pontos de dados ou amplitudes. 

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários

1 Navegue em um cromatograma 
para visualizar o íon precursor e o 
íon-produto dos últimos picos de 
Pest - STD 200 MRM.d.
• Aumente a visualização na 

região entre 13 e 16 minutos.
• Utilize o ícone Walk 

Chromatogram.
• Reveja os espectros começando 

a cerca de 13 minutso e, em 
seguida, mova a seta para a 
direita. 

a Marque a linha Pest - 200 - MRM.D na 
janela Data Navigator.

b Feche a janela do Method Editor.
c Feche a janela MS Spectrum Results.
d Clique o cromatograma TIC MRM na 

janela Data Navigator.
e Clique no ícone Autoscale Y-axis 

during Zoom  na barra de 
ferramentas Chromatogram Results.

f Selecione 1 para Maximum number of 
list panes.

g Para aumentar a visualização em 
alguns picos, clique com o botão 
direito do mouse sobre o pico a 13 
minutos e arraste-o até 16 minutos, 
em seguida, solte-o. 

h Clique no ícone Walk Chromatogram 
 na barra de ferramentas 

Chromatogram Results.
i Mova o cursor Walk Chromatogram 

sobre o eixo-X até cerca de 13 
minutos, em seguida, clique. 

j Para navegar de espectro a espectro, 
utilize as setas direita e esquerda de 
seu teclado.

• A ferramenta Walk Chromatogram é 
particularmente útil em dados 
MS/MS para a identificação de íons 
precursores e produtos.

• O espectro de cada ponto que você 
seleciona na janela Chromatogram 
Results é automaticamente exibido 
na janela Spectrum Preview, que é 
aberta automaticamente.

• Às vezes, dois espectros são 
exibidos na janela Spectrum 
Preview. Por exemplo, dois 
espectros são exibidos na janela 
Spectrum Preview para cada ponto 
que você clica próximo ao pico de 
13.431 minutos.
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Figura 18 Navegue pelo cromatograma para visualizar dois espectros MRM para o pico em 13. 43 minutos

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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2 Extraia espectros em pontos de 
dados específicos para o pico a 5.2 
minutos e para o pico a 14.3 
minutos do arquivo de dados Pest - 
STD 200 MRM.d.
• Extraia um espectro do pico ou 

próximo a 5.2 minutos e, em 
seguida, um dos vales, utilizando 
qualquer uma das opções 
descritas em Comentários.

• Extraia um espectro do pico ou 
próximo a 14.3 minutos. (ainda 
não no vale)

• Modifique a exibição para 
mostrar pelo menos três 
espectros.

a Clique no ícone Range Select  da 
barra de ferramentas Chromatogram 
Results.

b Feche a janela Spectrum Preview.
c Clique no ícone Zoom Out, , na 

barra de ferramentas Chromatogram 
Results.

d Para aumentar o zoom para o pico de 
5.2 minutos, clique com o botão drieito 
do mouse sobre o pico a 4.0 minutos e 
arraste-o para 6.0 minutos, em 
seguida, libere-o. 

e Em um pico próximo de 5.2 minutos, 
extraia um espectro de qualquer uma 
das formas listadas na coluna 
Comentários.

f Em um vale próximo a 5.1 minutos, 
extraia o espectro.

g Clique no ícone Zoom Out, , na 
barra de ferramentas Chromatogram 
Results.

h Aumente o zoom na região entre 14 e 
15 minutos. 

i Em um pico próximo de 5.2 minutos, 
extraia um espectro de qualquer uma 
das formas listadas na coluna 
Comments. (Não extraia o espectro do 
vale ainda.)

j Se necessário, selecione 4 no ícone 
Maximum number of list panes na 
barra de ferramentas MS Spectrum 
Results.

• Quando você aumenta o zoom, 
tenha certeza de que o ícone 
AutoScale Y-axis during Zoom,  
está “ligado”. O plano de fundo do 
ícone é laranja, quando ele está 
ligado.

• Você pode também extrair um 
espectro de uma das seguintes 
maneiras:
• Clique duas vezes sobre o ponto 

de dados do cromatograma. 
• Clique sobre o ponto de dados do 

cromatograma, em seugida, 
clique com o botão direito em 
qualquer parte do cromatograma. 
Clique em Extract MS Spectrum. 
A caixa de diálogo Extract 
Spectrum é exibida. Tenha 
certeza de que o arquivo Pest - 
STD 200 MRM.d está 
selecionado e clique em Extract 
na caixa de diálogo Extrac 
Spectrum.

• Observe que quando você extrai um 
espectro pela primeira vez, a janela 
MS Spectrum Results aparece 
contendo o espectro, o tipo de 
espectro e o tempo de retenção 
aparece sob Espectros de Usuário. 
Todos os espectros extraídos 
aparecem em ambos os lugares.

• Quando você extrai um espectro do 
MS a partir do pico próximo a 
14.3 minutos, dois espectros são 
extraídos porque duas transições 
acontecem durante o pico.

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
32 Agilent MassHunter Workstation Software - Análise Qualitativa Guia de Familiarização para GC/MS



Aprenda noções de análise qualitativa 1
Tarefa 9. Extrair espectros de um cromatograma
Figura 19 A janela principal com dois espectros MRM do pico a 5.2 minutos e dois espectros MRM do pico 
a 14.3 minutos.

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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3 Extraia um Espectro MS do vale a 
14.35 minutos do arquivo de dados 
Pest - STD 200 MRM.d. 
• Faça a Pré-visualização de 

Espectro
• Extraia um espectro do vale ou 

próximo a 14.3 minutos do RT.
• Copie o espectro para a pasta 

User Spectra.
• Modifique a exibição para 

mostrar 6 espectros.
• Desligue a Pré-visualização de 

Espectro.

a Clique sobre o ícone Spectrum 
Preview, .

b Em um vale próximo a 14.3 minutos, 
extraia um espectro.

c Clique com o botão direito sobre o 
espector na janela Spectrum Preview e 
clique em Copy to User Spectra. Os 
espectros são copiados para a sessão 
User Spectra em Data Navigator, e são 
exibidos na janela MS Spectrum 
Results.

d Clique com a seta para baixo próxima à 
lista de painel de espectros e 
selecione 6.

e Feche a janela Spectrum Preview.

• Quando Spectrum Preview está 
habilitado, o sistmea exibe qualquer 
espectro selecionado manualmente 
na janela Spectrum Preview, mas 
não na seção User Spectra do Data 
Navigator.

• Quando Spectrum Preview está 
ligado, a Qualitative Analysis 
sobrescreve o espectro anterior 
quando você extrai um novo 
espectro.

• O modo Specter Preview é útil 
quando você quer rapidamente 
revisar os espectros em seu 
cromatograma e salvar apenas 
alguns dos espectros.

Figura 20 Resultados do Cromatograma e janela MS Spectrum Results

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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4 Extraia um espectro que tenha a 
média de todos os pontos em uma 
amplitude especificada para o pico 
em 14.3 minutos para o arquivo de 
dadosPest - STD 200 MRM.d :
• Menos zoom.
• Clique no ícone Range Select da 

barra de ferramentas 
Chromatogram.

• Defina uma amplitude para todo 
o pico. 

• Extraia o espectro, utilizando 
qualquer uma das opções 
listadas.

a Clique sobre o ícone Range Select 
 na barra de ferramentas do 

Cromatograma.
b Clique no lado esquerdo da base do 

pico a 14.3 minutos e arraste-o para a 
base do pico à direita. 

c Extraia a média do espectro utilizando 
uma das opções à direita.

d Selecione 2 na caixa Maximum 
number of list panes, na janela MS 
Spectrum Results.

• Você pode extrair um espectro 
médio clicando duas vezes sobre a 
amplitude selecionada no 
cromatograma. 

• Ou clique com o botão direito sobre 
o cromatograma e, em seguida, 
clique em Extract MS Spectrum no 
menu de atalho.

• Observe que dois espectros de 
MRM com média aparecem.

Figura 21 Resultados de Cromatograma e Resultados de Espectro de MS exibindo dois espectros com média

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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5 Extraia os espectros que tenham 
as médias de picos a 5.2 minutos e 
a 14.3 minutos juntos, para o 
arquivo de dados Pest - STD 200 
MRM.d.
• Dica: Utilize o ícone Range 

Select e a tecla Ctrl para 
selecionar a amplitude do Pico 1, 
coletada a partir do ponto médio.

• Extraia os espectros utilizando 
uma das opções à direita.

a Clique no ícone Zoom Out, , na 
barra de ferramentas Chromatogram 
Results.

b Pressione a tecla Ctrl.
c Clique no lado esquerdo do pico a 

5.2 minutos e arraste-o para a direita 
do pico, em seguida, solte o mouse.

d Pressione a tecla Ctrl.
e Extraia os espectros com média 

usando esta opção ou aquela à direita:
• Clique duas vezes sobre a amplitude 

selecionada em qualquer um dos 
picos.

• Lembre-se de que o segundo pico já 
tem uma amplitude selecionada a 
partir do passo 4.

• Para extrair espectros, você pode 
também clicar com o botão direito 
sobre o cromatograma e clicar em 
Extract MS Spectrum. A caixa de 
diálogo Etract Spectrum é exibida. 
Clique em Extract.

Figura 22 Dois espectros com média a partir e duas amplitudes de tempo diferentes no cromatograma.

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários

O primeiro espetro tem transições de 
ambas as amplitudes de tempo. 
O segundo espectro tem apenas uma 
amplitude de tempo porque a 
transição a 160.00 -> ** não está 
presente no pico a 5.2 minutos.
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6 Subtraia um espectro de fundo 
para cada vez que você extrair um 
espectro de Pest - STD 200 
MRM.d.
• Exclua qualquer rastreamento 

sob User Spectra, em Data 
Navigator.

• Extraia um espectro de fundo 
que seja a média de um 
espectro, no início do pico, e um 
espectro no final do pico.

• Extraia um espectro da lista de 
picos integrados.

a Clique sobre a linha User Spectra em 
Data Navigator. Clique com o botão 
direito sobre a linha User Spectra e, 
em seguida, clique em Delete.

b Clique sobre Yes.
c No Method Explorer, selecione 

Spectrum > Extract (MS/MS). 
d Clique na aba Peak Spectrum 

Extraction (MS/MS), se não estiver 
visível.

e Na caixa Peak spectrum background 
MS/MS, selecione Average of 
spectra at peak start and end.

f Na barra de ferramentas 
Chromatogram Results, clique sobre o 
ícone Peak Select .

g Clique sobre o comando 
Chromatograms > Integrate.

h Selecione o pico a 5.206 minutos.
i Clique com o botão direitos e, em 

seguida, clique em Extract Peak 
Spectrum no menu de atalhos.

• Observe que, ao final deste 
processo, todos os picos de 
espectros extraídos terão, 
automaticamente, o espectro de 
plano de fundo designado 
subtraído.

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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Figura 23 Espectros de pico com espectro de pico de fundo subtraído

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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7 Integre e extraia os espectros de 
pico do arquivo de dados Pest - 
STD 200 MRM.d.

a Clique sobre o cromatograma TIC 
MRM na janela Data Navigator.

b Clique em Chromatograms > 
Integrate and Extract Peak Spectra.

• O espectro de pico que você extraiu 
manualmente no passo anterior é 
excluído automaticamente porque, 
por padrão, a caixa de marcação 
Clear previous peak spectra é 
marcada na aba Chromatograms > 
Integrate (MS/MS) > Results.

Figura 24 Integrar e Extrair os Espectros de Pico

8 Remover os resultados de 
integração e os espectros de pico.

a Selecione o arquivo de dados Pest - 
Std 200 MRM.d

b Clique em Chromatograms > Clear 
Results > Include Peak Spectra.

• Você pode, em vez disso, clicar em 
Chromatograms > Clear Results > 
Only Chromatograms, se você não 
quiser excluir o espectro de pico 
excluído.

Tarefa 9. Extrair espectros de um cromatograma

Etapas Instruções Detalhadas Comentários
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1 Aprenda noções de análise qualitativa
Tarefa 10. Adicionar anotações
Tarefa 10. Adicionar anotações

Você pode adicionar uma anotação de imagem ou anotação de texto à seguinte 
janela de gráficos:

• Janela Chromatogram Results

• Janela MS Spectrum Results

Se você tiver os resultados do arquivo de dados, anotações também serão 
salvas.

Tarefa 10. Adicionar anotações

Etapas Instruções Detalhadas Comentários

1 Selecione o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d. 
Esconda outros cromatogramas.

a Marque a caixa de marcação próxima a 
MSD_mix_4stds_DG_spl200_03.D na 
janela Data Navigator.

b Clique em Edit > Show > Only 
Highlighted.

• Os cromatogramas para os outros 
arquivos de dados são ocultados 
automaticamente.

2 Selecione o local no cromatograma 
onde você gostaria de adicionar a 
anotação de texto.

a Na janela Chromatogram Results, 
clique na ferramenta Annotation ( ) 
na barra de ferramentas.

b Mova o cursor para o local no painel 
do cromatograma onde você quer 
adicionar a anotação.

c Clique com o botão direito e, em 
seguida, clique em Add Text 
Annotation.

• O cursor mudará para uma mira. 
Você utilizará este cursor para 
selecionar a locação exata onde 
quer adicionar a anotação.

• A barra de ferramentas Annotate 
estará disponível na janela 
Chromatogram Results.

• Você também pode adicionar 
anotações à janela MS Spectrum 
Results.
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3 Adicione a informação sobre a 
anotação de texto na caixa de 
diálogo Add/Edit Text Annotation.

a Digite em Text a anotação.
b Selecione a cor em Text color.
c Selecione a orientação em 

Orientation.
d Selecione o tipo de fonte em Font style 

e o tamanho em Font size.
e Clique ou em Anchored, ou em 

Floating. Se você clicar em Anchored, 
poderá selecionar as opções para o 
indicador do texto da anotação. Se 
você clicar em Floating, poderá 
modificar a posição relativa. É mais 
fácil modificar a posição 
interativamente na janela gráficos.

f Clique em OK.

• Você pode adicionar múltiplas 
anotações a um cromatograma ou 
espectro.

• Você pode usar os ícones na barra 
de ferramentas Annotate para 
selecionar todas as anotações, 
excluir anotações e editar 
anotações.

Figura 25 A caixa de diálogo Add/Edit Text Annotation e a janela Chromatogram Results

Tarefa 10. Adicionar anotações (cont.)

Etapas Instruções Detalhadas Comentários

A barra de ferramentas Annotate está disponível apenas 
quando a ferramenta Annotate é selecionada.
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4 Selecione o local no cromatograma 
para adicionar a a notação da 
imagem.

a Mova o cursor para o local no painel 
do cromatograma onde você quer 
adicionar a anotação.

b Clique com o botão direito e, em 
seguida, clique em Add Image 
Annotation.

• Você pode adicionar um arquivo de 
imagme JPG ou MOL.

5 Adicione a informação sobre a 
anotação de texto na caixa de 
diálogo Add/Edit Text Annotation.

a Digite em Text a anotação.
b Digite 50 para a espessura em Scale.
c Marque a caixa de marcação Lock 

aspect ratio.
d Clique em Floating. Você pode alterar 

a posição relativa. É mais fácil 
modificar a posição interativamente na 
janela gráficos.

e Clique em OK.
f Mova a imagem para a o canto 

superior direito do cromatograma.

• O arquivo Agilent_Logo.tif está 
incluído na pasta \\MassHunter\
Report Templates\Qual\B.05.00\
en-US\Letter. Você precisa 
convertê-lo para um arquivo JPG.

• Você pode adicionar múltiplas 
anotações a um cromatograma ou 
espectro.

Figura 26 A caixa de diálogo Add/Edit Image Annotation e a janela Chromatogram Results.

Tarefa 10. Adicionar anotações (cont.)

Etapas Instruções Detalhadas Comentários
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6 Aumente a visualização para o 
primeiro pico.

• Aumente a visualização para uma área 
ao redor do primeiro pico a 5.5 minutos.

Figura 27 A caixa de diálogo Add/Edit Image Annotation e a janela Chromatogram Results.

7 Alterne novamente para a 
ferramenta Range Select na janeal 
Chromatogram Results. Exclua a 
anotação antes.

a Clique sobre o ícone  para 
remover todas as anotações.

b Clique sobre o ícone  (Range 
Select) na barra de ferramentas 
Chromatogram Results.

• Se você quiser salvar as anotações 
com os resultados do arquivo de 
dados, veja “Tarefa 17. Salvar 
resultados” na página 69.

• Você pode alternar entre cinco 
diferentes ferramentas na barra de 
ferramentas Chromatogram 
Results. Consulte a Ajuda online 
para mais informações. As cinco 
ferramentas são:
• Range Select
• Peak Select
• Manual Integration
• Walk Chromatogram
• Annotation Mouse

Tarefa 10. Adicionar anotações (cont.)

Etapas Instruções Detalhadas Comentários

Se a anotação estiver fixa, ela permanecerá 
na posição designada. Se você aumentar o 
zoom para um pico diferente, uma anotação 
fixa pode não ficar visível. Se uma anotação 
estiver flutuando, então ela sempre será 
exibida na mesma posição relativa ao canto 
superior esquerdo da janela.
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Tarefa 11. Adicione um compasso de massa

Um compasso exibe a diferença entre dois pontos em um espectro. Você pode 
adicionar um compasso à janela MS Spectrum Results.

Se você tiver os resultados do arquivo de dados, compassos também serão 
salvos.

Tarefa 11. Adicione um compasso de massa

Etapas Instruções Detalhadas Comentários

1 Integre e extraia o espectro 
de pico do 
MSD_mix_4stds_DG_spl200_03.d.

a Marque a caixa de marcação próxima a 
MSD_mix_4stds_DG_spl200_03.D na 
janela Data Navigator.

b Clique em Edit > Show > Only 
Highlighted.

c Clique em Chromatograms > 
Integrate and Extract Peak Spectra.

d Feche a janela do Method Editor.

2 Adicione um compasso para o 
espectro de pico criado na tarefa 
anterior.

a Na janela MS Spectrum Results, clique 
na ferramenta Delta Mass Caliper 
( ) na barra de ferramentas.

b (opcional) Selecione Profile Point to 
Point para o tipo de compasso na barra 
de ferramentas de Compasso.

c Aumente a visualização de 66 para 
132 m/z.

d Mova o cursor para o local no painel 
do espectro onde você quer adicionar 
o compasso.

e Arraste o cursor até o ponto final do 
compasso no espectro. Enquanto você 
arrasta o cursor, o valor da massa delta 
será modificado. Quando você soltar o 
botão do mouse, o compasso será 
adicionado. 

• O cursor será mudado para uma 
seta. Você utilizará este cursor para 
definir um ponto inicial e final para o 
compasso. 

• Você não pode selecionar o tipo de 
compasso se o espectro for 
centróide, porque Profile Point to 
Point não tem efeito sobre dados 
centróides.

• O cursor “triângulo” é definido para 
o topo do pico selecionado.
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3 Modifique o compasso para utilizar 
uma cor diferente.

a Clique sobre o compasso criado no 
passo anterior.

b Clique sobre o botão 
Propriedades do Compasso ( ) 
na barra de ferramentas 
MS Spectrum Results Caliper.

c (opcional) Diigte os valores de Start X 
e de Start Y.

d Selecione a cor em Text color.
e Selecione o tipo de fonte em Font style 

e o tamanho em Font size.
f Clique em OK.

• Você pode adicionar múltiplos 
compassos a um espectro.

• Você pode utilizar os ícones na 
barra de ferramentas Caliper para 
selecionar todos os compassos, 
excluir compassos ou editá-los.

Figura 28 A caixa de diálogo Delta Mass Caliper Settings e a janela MS Spectrum Results

4 Excluir resultados de integração e 
espectros.

a Clique em Chromatograms > Clear 
Results > Include Peak Spectra.

b Clique na ferramenta Range Select.

• Se você quiser salvar os compassos 
para os resultados de arquivos de 
dados, consulte “Tarefa 17. Salvar 
resultados” na página 69.

Tarefa 11. Adicione um compasso de massa (cont.)

Etapas Instruções Detalhadas Comentários
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Tarefa 11. Adicione um compasso de massa
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Guia de Familiarização
2
Encontre e Identifique

Encontre compostos pela deconvolução do cromatograma 48

Identifique compostos utilizando o algoritmo Search Library 52

Tarefa 14. Encontre compostos por MRM (MRM apenas) 57

Tarefa 15. Encontre compostos por Integração 61

Tarefa 16. Gere fórmulas e busque na biblioteca por espectros de pico 64

Tarefa 17. Salvar resultados 69

Nestas tarefas, você encontrará e identificará compsotos em arquivos de 
dados GC/MS.

Cada exercício é apresentado em uma tabela com três colunas:

• Passos – Use instruções gerais para proceder por conta própria, explorando 
o programa.

• Instruções Detalhadas – Utilize-as se você precisar de ajuda ou se preferir 
um processo de aprendizado passo-a-passo.

• Comentário – Leia-os para obter dicas e informação adicional sobre cada 
passo no exercício.
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Encontre compostos pela deconvolução do cromatograma
Encontre compostos pela deconvolução do cromatograma

O algoritmo FindCompounds identifica compostos em dados GC/MS e cria um 
espectro MS limpo para cada composto. Esta função é um modo fácil de “mina” 
informações de dados complexos. Você pode usar apenas o algoritmo Find 
Compounds by Chromatogram Deconvolution em dados de amostra do GC/MS 
adquiridos no modo de rastreamento Scan, Product Ion Scan ou Neutral Loss.

A tarefa exibe compostos por deconvolução de cromatograma com dados de 
massa precisos. Você também pode encontrar compostos por deconvolução do 
cromatograma com dados de massa de unidade após você modificar a 
primeira janela de extração.

Tarefa 12. Encontre compostos utilizando Chromatogram Deconvolution (GC/MS)

Etapa Instruções Detalhadas Comentários

1 Abra o TIC para o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d.

a Se o programa não estiver aberto, 
clique duas vezes no ícone 
MassHunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique sobre o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d na 
pasta de arquivo de dados GC.

c Limpe a caixa de seleção Load result 
data e clique em Open.

• O algoritmo Find Compounds by 
Chromatogram Deconvolution 
funciona com ambos os arquivos de 
dados GC/QQQ e GC/Q-TOF.

Figura 29 O cromatograma TIC a partir de Pest - 200 - Scan.d

2 Configure a interface do usuário 
para que funcione com os dados do 
CG.

• Siga as instruções apresentadas em 
“Tarefa 2. Configurar Interface de 
Usuário para dados GC/MS” na 
página 13.

• Para estes exemplos, selecione o 
fluxo de trabalho do GC/Q-TOF 
Compound Screening.
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3 Encontre compostos utilizando o 
algoritmo de deconvolução do 
cromatograma.
• Selecione o integrador Agile.
• Insira um limite SNR de 20.
• Insira 100 ppm para os valores 

Left m/z delta e Right m/z 
delta.

a Na janela Method Explorer, selecione 
Find Compounds > Find by 
Chromatogram Deconvolution.

b Na aba Configurações, sob filtro de 
Pico, digite 20 para o limite SNR.

c Selecione PPM para m/z delta units.
d Insira 100 para Left m/z delta e 

100 para Right m/z delta.

• A seção Find by Chromatogram 
Deconvolution também está 
disponível na seção GC/Q-TOF 
Compound Screening.

• Se você tem dados de massa de 
unidade, você deve inserir 
0.3 AMU para o valor de Left m/z 
delta e 0.7 AMU para o valor de 
Right m/z delta.

• Você pode extrair o conjunto de 
resultados completos para um 
composto após encontrá-lo usando 
o item do menu Compounds > 
Extract Complete Result Set, 
quando um composto for 
destacado.

Figura 30 Aba de configurações na seção Find by Chromatogram 
Deconvolution.

Tarefa 12. Encontre compostos utilizando Chromatogram Deconvolution (GC/MS)

Etapa Instruções Detalhadas Comentários
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• Selecione extrair EIC, espectro 
MS e espectro MS/MS.

e Clique na aba Results.
f Marque as caixas de marcação Extract 

EIC, Extract ECC, Extract cleaned 
spectrum e Extract raw spectrum.

g Clique em  para rodar o algoritmo 
Find Compounds by Chromatogram 
Deconvolution no arquivo de dados. 

h Se necessário, clique no comando 
View > Compound List command.

• O programa Qualitaitve Analysis 
encontra até 4 compostos sob estas 
condições.

• Se o arquivo de dados não estiver 
indexado, pode levar bastante 
tempo para executar este algoritmo.

4 Examine os compostos. Consulte 
Figura 31 na página 51.

a Selecione 2 na caixa Maximum 
number of list panes, na caixa de 
ferramentas MS Spectrum Results.

b Clique sobre o ícone Hide Empty 
Columns na janela Compound List.

c Clique sobre o primeiro composto na 
janela Data Navigator. 

d Quando a janela Data Navigator 
estiver selecionada, utilize as setas do 
teclado para alternar compostos. 

• Exibir ambos os espectros é um modo 
conveniente de se exibir toda a 
informação para um único composto.

• Observe que tanto o espectro limpo, 
quanto o espectro sujo são exibidos.

Tarefa 12. Encontre compostos utilizando Chromatogram Deconvolution (GC/MS)

Etapa Instruções Detalhadas Comentários
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Encontre compostos pela deconvolução do cromatograma
Figura 31 Encontre Compostos por meio dos resultados de Deconvolução do Cromatograma

Tarefa 12. Encontre compostos utilizando Chromatogram Deconvolution (GC/MS)

Etapa Instruções Detalhadas Comentários
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Identifique compostos utilizando o algoritmo Search Library
Identifique compostos utilizando o algoritmo Search Library

Nesta tarefa, você identificará e gerará fórmulas para os compostos 
encontrados em “Encontre compostos pela deconvolução do 
cromatograma” na página 48. Você pode realizar esta tarefa se você tiver 
comprado a biblioteca NIST08.l ou se utilizar a biblioteca demo.l. Se você tem 
duas bibliotecas, você pode selecionar ambas.
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Identifique compostos utilizando o algoritmo Search Library
Tarefa 13. Identifique compostos utilizando o algoritmo Search Library.

Etapa Instruções Detalhadas Comentários

1 Realize uma busca de biblioteca de 
todos os compostos no arquivo de 
dados 
MSD_mix_4stds_DG_spl200_03.d.

a Destaque os compsotos no arquivo de 
dados 
MSD_mix_4stds_DG_spl200_03.D na 
janela Data Navigator.

b Na janela Method Explorer, clique em 
Identify Compounds > Search Unit 
Mass Library.

c Na aba Settings, clique no botão Add 
Library. Selecione a biblioteca demo.l 
e clique sobre o botão OK.

d (opcional) Na aba Settings, clique no 
botão Add Library. Selecione a 
biblioteca NIST08.l e clique sobre o 
botão OK.

e Clique na aba Search Results.
f (opcional) Selecione Stop When 

Found para o modo de busca 
Multi-Library.

g Clique em Identify > Search Library 
for Compounds no menu principal. 
Você pode, em vez disso, clicar sobre o 
ícone Search Library for Compounds 

 para executar o algoritmo.
h Clique em View > Difference Results.
i Clique em View > Structure Viewer.
j Clique em View > Compound 

Identification Results, se necessário, 
para exibir esta janela.

k Se necessário, clique sobre a aba para 
abrir a janela Compound Identification 
Results. Esta janela tem abas com a 
janela Chromatogram Results.

• Você também pode clicar em 
GC/Q-TOF Compound Screening > 
Identify by Library Search no 
Method Explorer. A mesma seção 
na janela do Method Editor é 
exibida.

• Demo.l e Nist08 devem estar 
instalados na pasta \MassHunter\
Library.

• Observe que muitos compostos são 
identificados após buscar na 
biblioteca NIST08.l.

• Se você não tiver a biblioteca 
NIST08.l, selecione uma outra 
biblioteca que você tenha 
disponível.

• Se você tiver duas ou mais 
bibliotecas selecionadas e você 
selecionar Stop When Found, o 
algoritmo de busca da biblioteca 
buscará pela primeira biblioteca da 
lista. Se o composto for 
identificado, então ele será 
interrompido. Se o composto não 
for identificado, então ele buscará 
pela próxima biblioteca até que o 
composto seja identificado ou até 
que a última biblioteca tenha sido 
buscada.

• Você utiliza o programa Library 
Editor para modificar bibliotecas 
que você utiliza com o algoritmo 
Search Unit Mass Library. 
Este programa é instalado com 
o programa Agilent 
MassHunter Quantitative 
Analysis. Clique no ícone  
para iniciar este
programa.
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2 Exiba as colunas Spectral Library 
Results na janela Compound List e 
na janela Compound Identification 
Results.

a Clique no botão Show Library Search 
Column ( ) na barra de 
ferramentas Compound List e na barra 
de ferramentas Compound 
Identification Results.

b Clique no botão Hide Empty Columns 
( ) na barra de ferramentas 
Compound List e na barra de 
ferramentas Compound Identification 
Results.

Figura 32 Compostos no arquivo de dados MSD_mix_4stds_DG_spl200_03.D e nos resultados de busca da 
biblioteca

Tarefa 13. Identifique compostos utilizando o algoritmo Search Library.

Etapa Instruções Detalhadas Comentários
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Identifique compostos utilizando o algoritmo Search Library
3 Alterne para Compound Details 
View para revisar os compostos.

a Clique em  na 
barra de ferramentas principal.

b Feche a janela Compound Fragment 
Spectrum Results.

4 Reveja os resultados em 
Compound Details View.

a Clique sobre o ícone Overlaid na janela 
Compound Chromatogram Results.

b Expanda os resultados na janela 
Compound Chromatogram Results.

• Você pode descobrir mais sobre a 
Compound Details View na Ajuda 
online. A Compound Details View é 
muito útil quando você procura por 
resultados do algoritmo Find by 
Formula com um arquivo de dados 
adquirido no modo All Ions.

Figura 33 Compound Details View exibindo compostos no arquivo de dados 
MSD_mix_4stds_DG_spl200_03.D

Tarefa 13. Identifique compostos utilizando o algoritmo Search Library.

Etapa Instruções Detalhadas Comentários
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2 Encontre e Identifique
Identifique compostos utilizando o algoritmo Search Library
5 Volte para a Visualização de 
Navegador.

• Clique sobre o botão 
 na barra de 

ferramentas principal.

6 Feche o arquivo de dados. a Clique em File > Close Data File.
b Clique em No.

• Se você quiser salvar estes 
resultados, veja “Tarefa 17. Salvar 
resultados” na página 69.

Tarefa 13. Identifique compostos utilizando o algoritmo Search Library.

Etapa Instruções Detalhadas Comentários
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Tarefa 14. Encontre compostos por MRM (MRM apenas)

O algoritmo Find Compounds by MRM identifica compostos em dados MRM a 
partir de um Quadrupolar Triplo. A busca de algoritmos para compostos 
utilizando transições MRM. Todos os compostos no método de aquisição são 
extraídos e exibidos na Compound List. Os compostos não são eliminados com 
base nos resultados de integração do cromatograma. Você pode usar o Find 
Compounds apenas através do algoritmo MRM em dados que foram adquiridos 
utilizando transições MRM. O algoritmo MRM utiliza informações que foram 
encontradas no arquivo de dados se o arquivo de dados for um arquivo de 
dados MRM.

Tarefa 14. Encontre compostos por MRM (MRM apenas)

Etapa Instruções Detalhadas Comentários

1 Abra o TIC para o arquivo de dados 
Pest - STD 200 MRM.d.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique no arquivo de dados Pest - STD 
200 MRM.d, na pasta de arquivos de 
dados de exemplo GC.

c Limpe a caixa de seleção Load result 
data e clique em Open.

• Você deve utilizar o General 
Workflow quando trabalhar com 
dados GC/QQQ. Você utiliza ou o 
General Workflow ou o fluxo de 
trabalho GC/Q-TOF Compound 
Screening quando trabalha com 
dados do GC/Q-TOF.

Figura 34 O cromatograma TIC a partir de Pest - STD 200 MRM.d

2 Configure a interface do usuário 
para que funcione com os dados 
do CG.

• Siga as instruções apresentadas em 
“Tarefa 2. Configurar Interface de 
Usuário para dados GC/MS” na 
página 13.
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3 Encontre compostos utilizando o 
algoritmo MRM.

a Na janela Method Explorer, selecione 
Find Compounds > Find by MRM.

b Clique no botão Group transitions by 
compound name.

c Clique sobre a aba Integrator.
d Selecione o integrador Agile.

• Você pode optar pela região do 
cromatograma a partir da qual você 
pretende encontrar os compostos. 

• Você pode extrair o conjunto de 
resultados completos para um 
composto após encontrá-lo usando 
o item do menu Compounds > 
Extract Complete Result Set, 
quando um composto for 
destacado.

Figura 35 A aba do integrador na seção Find by MRM do Method Editor.

e Clique em  para rodar o algoritmo 
Find Compounds by MRM no arquivo 
de dados. 

f Se necessário, clique no comando 
View > Compound List command.

g Se necessário, clique no comando 
View > Compound Identification 
Results.

• O programa Qualitaitve Analysis 
encontra até 28 compostos sob 
estas condições.

Tarefa 14. Encontre compostos por MRM (MRM apenas)

Etapa Instruções Detalhadas Comentários
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Tarefa 14. Encontre compostos por MRM (MRM apenas)
4 Examine os compostos. Consulte 
Figura 36 na página 59.

a Selecione 2 na caixa Maximum 
number of list panes, na caixa de 
ferramentas MS Spectrum Results.

b Clique no ícone Automatically Show 
Columns na janela Compound List e na 
janela Compound Identification 
Results.

c Clique sobre o primeiro composto na 
janela Data Navigator. 

d Quando a janela Data Navigator 
estiver selecionada, utilize as setas do 
teclado para alternar compostos. 

• O íon precursor é exibido na coluna 
Precursor (Acq Method) e o íon 
produto é exibido na coluna Product 
(Acq Method) na janela Compound 
Identification Results.

Figura 36 Encontre os resultados do MRM.

Tarefa 14. Encontre compostos por MRM (MRM apenas)

Etapa Instruções Detalhadas Comentários
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Tarefa 14. Encontre compostos por MRM (MRM apenas)
5 Feche o arquivo de dados. a Clique em File > Close Data File.
b Clique em Close.

• Se você quiser salvar estes 
resultados, veja “Tarefa 17. Salvar 
resultados” na página 69.

Tarefa 14. Encontre compostos por MRM (MRM apenas)

Etapa Instruções Detalhadas Comentários
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Tarefa 15. Encontre compostos por Integração

O algoritmo Find Compounds by Integration identifica compostos com base 
nos resultados de integração. Um compsoto é criado para cada pico que é 
identificado pelo integrador.

Tarefa 15. Encontre compostos por Integração

Etapa Instruções Detalhadas Comentários

1 Abra o TIC para o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.D.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique no arquivo de dados Pest - STD 
200 MRM.d, na pasta de arquivos de 
dados de exemplo GC.

c Limpe a caixa de seleção Load result 
data e clique em Open.

• Você deve utilizar o General 
Workflow quando trabalhar com 
dados GC/QQQ. Você utiliza ou o 
General Workflow ou o fluxo de 
trabalho GC/Q-TOF Compound 
Screening quando trabalha com 
dados do GC/Q-TOF.

Figura 37 Cromatograma TIC de MSD_mix_4stds_DG_spl200_03.d

2 Configure a interface do usuário 
para que funcione com os dados 
do CG.

• Siga as instruções apresentadas em 
“Tarefa 2. Configurar Interface de 
Usuário para dados GC/MS” na 
página 13.

3 Encontre compostos utilizando o 
algoritmo de integração.

a Na janela Method Explorer, selecione 
Find Compounds > Find by 
Integration.

b Selecione o integrador MS/MS (GC).

• Você pode optar pela região do 
cromatograma a partir da qual você 
pretende encontrar os compostos. 

• Você pode extrair o conjunto de 
resultados completos para um 
composto após encontrá-lo usando 
o item do menu Compounds > 
Extract Complete Result Set, 
quando um composto for 
destacado.
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Tarefa 15. Encontre compostos por Integração
Figura 38 A aba do integrador na seção Find by Integration do Method Editor.

c Clique em  para executar o 
algoritmo Find Compounds by 
Integration no arquivo de dados. 

d Se necessário, clique no comando 
View > Compound List command.

• O programa Qualitaitve Analysis 
encontra até 6 compostos sob estas 
condições.

4 Examine os compostos. Consulte 
Figura 36 na página 59.

a Selecione 2 na caixa Maximum 
number of list panes, na caixa de 
ferramentas MS Spectrum Results.

b Clique sobre o ícone Automatically 
Show Columns na janela Compound 
List.

c Clique sobre o primeiro composto na 
janela Data Navigator. 

d Quando a janela Data Navigator 
estiver selecionada, utilize as setas do 
teclado para alternar compostos. 

Tarefa 15. Encontre compostos por Integração

Etapa Instruções Detalhadas Comentários
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Tarefa 15. Encontre compostos por Integração
Figura 39 Encontre por resultados de Integração.

5 Feche o arquivo de dados. a Clique em File > Close Data File.
b Clique em Close.

• Se você quiser salvar estes 
resultados, veja “Tarefa 17. Salvar 
resultados” na página 69.

Tarefa 15. Encontre compostos por Integração

Etapa Instruções Detalhadas Comentários
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Tarefa 16. Gere fórmulas e busque na biblioteca por espectros 
de pico

Nesta tarefa, você primeiro integra e extrai os espectros de pico de um arquivo 
de dados GC/Q-TOF. Em seguida, você gera fórmulas possíveis para cada 
espectros de pico.

Tarefa 16. Gere fórmulas e busque na biblioteca por espectros de pico

Etapa Instruções Detalhadas Comentários

1 Abra o TIC para o arquivo de dados 
MSD_mix_4stds_DB_spl200_03.d.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique sobre o arquivo de dados 
MSD_mix_4stds_DB_spl200_03.d na 
pasta de arquivo de dados GC.

c Limpe a caixa de seleção Load result 
data e clique em Open.

• Se a caixa de marcação Load result 
data não estiver disponível, então 
nenhum resultado foi salvo no 
arquivo de dados. Veja “Tarefa 17. 
Salvar resultados” na página 69 
para mais instruções sobre como 
salvar resultados.

2 Integre e extraia o espectro de pico a Clique na seção Cromatogramas > 
Integrar (MS) na janela do Method 
Explorer.

b Clique na aba Peak Filters.
c Clique no botão Peak height.
d Marque a caixa de marcação Relative 

height.
e Marque a caixa de marcação Limit (by 

height) to the largest e o tipo 4.
f Clique em Chromatograms > 

Integrate and Extract Peak Spectra.
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3 Gere fórmulas para cada espectro 
de pico.
• Visualize a Spectrum 

Identification Results List.
• Feche a janela MS Spectrum 

Results.

Dica: Para obter os mesmos 
resultados de Figura 41, garanta que 
você selecionou Common organic 
molecules como modelo de isótopo.

a Na janela Method Explorer, clique em 
Identify Compounds > Generate 
Formulas.

b Na janela Method Editor, clique na aba 
Charge State e selecione Common 
organic molecules como modelo de 
Isótopo.

c Na janela Data Navigator, destauqe 
todos os espectros na seção User 
Spectra.

d Clique no comando Identify > 
Generate Formulas from Spectrum 
Peaks ou no botão Generate Formulas 
from Spectrum Peaks  para 
executar o algoritmo.

e Se necessário, clique no ícone 
Spectrum Identification Results, , 
ou clique no comando View > 
Spectrum Identification Results.

f Na janela Spectrum Identification 
Results, clique no botão Automatically 
Show Columns na barra de 
ferramentas.

g Clique no ícone Hide Empty Columns, 
, na janela Spectrum Identification 

Results.
h Selecione C6 H13 como resultado 

Best.
i Expanda a tabela para esta sequência.
j Feche a janela do Method Editor.
k Reveja as Formula and Ion Species que 

são exibidas muitos picos da janela 
MS Spectrum Review. Todas as 
Formula and Ion Species são da 
mesma cor que o espectro.

• Você pode ver as razões de 
abundância do isótopo previsto no 
quando seu zoom estiver na m/z 
apropriada. Consulte a Ajuda online 
para mais informações.

• O ícone Run , na barra de 
ferramentas do Method Editor, às 
vezes permite que você escolha 
uma ação a partir de um conjunto 
de ações possíveis. Por exemplo, 
duas ações diferentes são possíveis 
quando você clica no ícone 
Executar nesta seção. Se você 
clicar sobre a seta, uma lista de 
ações possíveis será exibida, e você 
pode escolher que ação executar. 
Escolher uma ação diferente da 
lista, modifica a ação padrão. Se 
você simplesmente clicar sobre o 
botão Run, a ação padrão atual será 
realizada.

• Você pode modificar a largura de 
uma coluna arrastando a linha que a 
separa das colunas adjacentes.

• Você pode movr a coluna 
arrastando seu cabeçalho.

• Você pode excluir uma coluana 
clicando em Remover coluna no 
menu de atalhos, na tabela.

Tarefa 16. Gere fórmulas e busque na biblioteca por espectros de pico

Etapa Instruções Detalhadas Comentários
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Figura 40 Gerar resultados de Fórmula para picos de 1 a 4

4 Faça uma busca na biblioteca 
pelos espectros de pico de 1 a 4

a Na janela Data Navigator, clique em 
User Spectra.

b Na janela Method Explorer, clique em 
Identify Compounds > Search Unit 
Mass Library.

c Verifique se uma biblioteca válida está 
selecionada.

d Clique em Identify > Search Library 
for Compounds no menu principal.

e Feche a janela do Method Editor.

• O Method Editor é aberto 
automaticamente quando você abre 
uma seção do Method Explorer.

Tarefa 16. Gere fórmulas e busque na biblioteca por espectros de pico

Etapa Instruções Detalhadas Comentários
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5 Modificar as colunas visíveis. a Clique com o botão direito sobre a 
janela Spectrum Identification Results 
e clique em Add/Remove Columns. 
Na caixa de diálogo “(Enhanced) 
Add/Remove Columns”, marque as 
colunas que você quer exibir. Clique 
em OK.

b Feche a janela do Method Editor.
c Clique no ícone Hide Empty Columns, 

, na janela Spectrum Identification 
Results.

d Reveja as Formula and Ion Species que 
são exibidas acima de cada pico da 
janela MS Spectrum Review.

• Se você utilizar o comando Remove 
Column e remover uma coluna que 
contém dados, o software irá 
automaticamente reexibir esta 
coluan se a função Automatically 
Show Columns estiver ativa.

• O algoritmo LibSearch tem grande 
peso na seção Combine 
Identification Results do método. 
Você pode escolher manualmente o 
resultado MFG ou escohler como os 
resultados de identificação são 
combinados.

Figura 41 Os resultados de Library Search and Generate Formulas para o primeiro pico de espectros.

Tarefa 16. Gere fórmulas e busque na biblioteca por espectros de pico

Etapa Instruções Detalhadas Comentários
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6 Reveja os resultados para cada 
espectro na janela MS Peaks One.

a Clique em View >MS Spectrum Peak 
List 1.

b Clique com o botão direito e clique em 
Add/Remove Column.

c Verifique as colunas exibidas em 
Figura 42 estão no Show these 
columns.

d Organize pela coluna Ion Type.
e Se o Tipo de Íon for Fragment Ion, 

então Formula & Ion Species será 
exibida em verde em cada pico no 
janela MS Spectrum Results.

• Os íons de fragmento são exibidos 
em verde na janela MS Spectrum 
Results.

• O Ion Type pode ser Molecular Ion, 
Fragment Ion ou nulo. Se for um Íon 
de Fragmento, em seguida, as 
colunas Loss Formula e Loss Mass 
exibem a fórmula e a massa para se 
chegar até aquele íon a partir do Íon 
Molecular. A Formula & Ion Species 
exibe a fórmula e as espécies de íon 
para aquele íon.

Figura 42 Tablea MS Peaks One com colunas Ion Type, Loss Formula, Loss Mass 
e Formula & Ion Species

7 (opcional) Feche o arquivo de 
dados.
• Você pode proceder para a 

próxima tarefa para aprender a 
como salvar os resultados.

a Clique em File > Close Data File.
b Clique em Close.

• Se você quiser salvar estes 
resultados, veja “Tarefa 17. Salvar 
resultados” na página 69.

Tarefa 16. Gere fórmulas e busque na biblioteca por espectros de pico

Etapa Instruções Detalhadas Comentários
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Tarefa 17. Salvar resultados

Nesta tarefa, você salvou os resultados para o atual arquivo de dados.

Tarefa 17. Salvar resultados

Etapa Instruções Detalhadas Comentários

1 Salve os resultados para o atual 
arquivo de dados e feche o arquivo 
de dados.

a Clique em File > Save Results.
b Clique em File > Close Data File.

• Você apenas pode salvar um dos 
conjuntos de resultados com um 
arquivo de dados. Se você já salvou 
resultados com o arquivo de dados 
atual, então estes resultados serão 
sobrescritos quando você clicar em 
File > Save Results.

2 Abra o arquivo de dados e carregue 
os resultados.

a Clique em File > Open Data File. 
A caixa de diálgoo “Open Data Files” 
se abre.

b Selecione um arquivo de dados. Para 
este exemplo, selecione um arquivo de 
dados para 
MSD_mix_4stds_DG_spl200_03.d.

c Marque a caixa de marcação Load 
result data.

d Clique no botão Open.
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2 Encontre e Identifique
Tarefa 17. Salvar resultados
Figura 43 Caixa de diálogo Open Data File.

3 Examine os resultados. a Clique na janela Spectrum 
Identification Results.

b Reveja os resultados.

•

Tarefa 17. Salvar resultados

Etapa Instruções Detalhadas Comentários

A caixa de marcação Load Result Data estará marcada.
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Encontre e Identifique 2
Tarefa 17. Salvar resultados
Figura 44 Os resultados de Library Search and Generate Formulas para o primeiro pico de espectros.

4 Feche o arquivo de dados. a Clique em File > Close Data File.
b Clique em Close.

5 Abra o arquivo de dados e não 
carregue os resultados.

a Clique em File > Open. A caixa de 
diálgoo “Open Data Files” se abre.

b Selecione um arquivo de dados. Para 
este exemplo, selecione um arquivo de 
dados para 
MSD_mix_4stds_DG_spl200_03.d.

c Limpe a caixa de marcação Load result 
data.

d Clique no botão Open.

• Se você não carregar os resultados, 
então, por definição, um TIC será 
aberto quando você abrir o arquivo 
de dados. Se você marcar ações 
Run 'File Open' da caixa de 
marcação de métodos selecionada, 
então as ações File Open serão 
abertas, em vez disso. Consulte a 
Ajuda online para mais 
informações.

Tarefa 17. Salvar resultados

Etapa Instruções Detalhadas Comentários
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Tarefa 17. Salvar resultados
Figura 45 Os resultados de Library Search and Generate Formulas para o primeiro pico de espectros.

6 Feche o arquivo de dados. a Clique em File > Close Data File.
b Clique em Close.

Tarefa 17. Salvar resultados

Etapa Instruções Detalhadas Comentários
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Guia de Familiarização
3
Utilize fluxos de trabalho, exporte 
e imprima

Defina e execute o método de análise qualitativa usando o fluxo de 
trabalho geral 74

Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho 
GC/Q-TOF Compound Screening 79

Tarefa 20. Exporte um arquivo CEF 83

Tarefa 21. Imprima um relatório de análise 85

Tarefa 22. Imprima um relatório de composto 88

Nestas tarefas, você aprende a definir e a executar um método de análise 
qualitativa. Em seguida, você executa ações no método automatizado quando 
você abre um arquivo de dados. 

Dois diferentes fluxos de trabalho são usados para estes exemplos. Consulte 
“Fluxos de Trabalho” na página 100 para mais informações.

O fluxo de trabalho General aceita dados do GC/QQQ, GC/Q-TOF e LC/MS. O 
fluxo de trabalho GC/Q-TOF Compound Screening aceita dados do GC/Q-TOF.

Cada exercício é apresentado em uma tabela com três colunas:

• Passos – Use instruções gerais para proceder por conta própria, explorando 
o programa.

• Instruções Detalhadas – Utilize-as se você precisar de ajuda ou se preferir 
um processo de aprendizado passo-a-passo.

• Comentário – Leia-os para obter dicas e informação adicional sobre cada 
passo no exercício.
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Defina e execute o método de análise qualitativa usando o fluxo de trabalho geral
Defina e execute o método de análise qualitativa usando o fluxo de 
trabalho geral

Quando você iniciar pela primeira vez o programa Análise Qualitativa, o 
método padrão default.m será carregado. Você pode fazer alterações ao 
método aberto e salvá-lo, bem como abrir um novo método, fazer alterações e 
salvar o método. Você não pode sobrescrever o método default.m.

Você também pode definir ações de execução específicas no método quando 
abrir um arquivo de dados. Quando você abre um arquivo de dados, você 
também pode carregar o método que foi usado para criar os resultados 
armazenados no arquivo de dados. Este método é automaticamente salvo 
quando quer que você salve os resultados com o arquivo de dados. O fluxo de 
trabalho Geral pode ser usado tanto com os arquivos de dados do GC/MS, 
quanto do LC/MS.

Tarefa 18. Defina e execute o método de análise qualitativa usando o fluxo de trabalho Geral.

Etapas Instruções Detalhadas Comentários

1 Abra o TIC para o arquivo de dados 
Pest - STD 200 MRM.d.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique no arquivo de dados Pest - STD 
200 MRM.d, na pasta de arquivos de 
dados de exemplo GC.

c Limpe a caixa de seleção Load result 
data e clique em Open.

• Você utiliza ou o Fluxo de Trabalho 
Geral ou o fluxo de trabalho de 
Rastreamento de Composto 
GC/Q-TOF quando trabalha com 
dados do CG/MS.

2 Configure a interface do usuário 
para que funcione com os dados do 
CG.

• Siga as instruções apresentadas em 
“Tarefa 2. Configurar Interface de 
Usuário para dados GC/MS” na 
página 13.

• Para este exemplo, selecione o 
fluxo de trabalho Geral.

3 Defina o método para extrair um 
cromatograma TIC. 
• Defina um cromatograma TIC 

para os dados do MS.

a Na janela Method Explorer, selecione 
Chromatogram > Define 
Chromatograms.

b Exclua o cromatograma BPC.
c Selecione TIC como o Type.
d Tenha certeza de que o Nível MS é 

MS/MS.
e Clique em Add.
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Defina e execute o método de análise qualitativa usando o fluxo de trabalho geral
4 Edite o método para integrar os 
dados.
• Limite a integração aos quatro 

picos mais altos.

a Na janela Method Explorer, selecione 
Chromatogram > Integrate (MS/MS)

b Clique na aba Peak Filters.
c Na seção Maximum number of peaks, 

marque a caixa de seleção Limit (by 
height) to the largest.

d Tipo 4. 

• Atualizando um valor na aba Peak 
Filters, na seção Chromatogram > 
Integrate (MS), você também 
atualiza valores em outras seções 
do Method Explorer. Triângulos 
azuis parecem exibir estas outras 
seções.

Figura 46 A aba Chromatogram > Integrate (MS/MS) > Peak Filters tab

5 Tsete a integração para garantir 
que apenas 4 picos integrados 
aparecem.

• Clique no ícone Integrate 
Chromatogram  para integrar o 
arquivo de dados. 

6 Salve o método como 
iii_GCexercise1, onde “iii” são 
suas iniciais.

a No menu superior, clique em 
Method > Save As.

b Digite iii_GCexercise1.
c Clique no botão Salvar.

• Observe que salvar o método faz 
com que os triângulos azuis fazem 
com que as mudanças de valores no 
método aberto desapareçam.

7 Altere o plano de fundo do 
espectro de método para utizar o 
espectro no início de um pico.

a Na janela Method Explorer, selecione 
Spectrum > Extract (MS/MS)

b Clique em Peak Spectrum Extraction 
(MS/MS).

c Para o plano de fundo do espectro de 
Pico, selecione Spectrum at peak 
start.

• Se você fizer qualquer modificação 
adicional após salvar o método, 
então um triângulo azul será 
adicionado.

Tarefa 18. Defina e execute o método de análise qualitativa usando o fluxo de trabalho Geral.

Etapas Instruções Detalhadas Comentários

Você pode clicar no ícone 
Save Method para salvar o 
método atual.
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Defina e execute o método de análise qualitativa usando o fluxo de trabalho geral
Figura 47 Aba Spectrum > Extract (MS/MS) > Peak Spectrum Extraction (MS/MS)

8 Teste a extração do espectro MS 
para garantir que um espectro de 
plano de fundo foi subtraído.

• Clique no ícone Extract Peak 
Spectrum  para executar a ação 
em um pico selecionado, no arquivo de 
dados. 

9 Grave o método. • Salve o método de uma das três 
seguintes formas:
• Clique no ícone Save Method 

no Method Editor.
• Clique com o botão direito no 

Method Editor, depois, clique em 
Save Method.

• No menu superior, clique em 
Method > Save.

• O ícone Save Method é exibido em 
Figura 47 na página 76

Tarefa 18. Defina e execute o método de análise qualitativa usando o fluxo de trabalho Geral.

Etapas Instruções Detalhadas Comentários

Você pode clicar no ícone 
Save Method para salvar o 
método atual.
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10 Defina um método para 
automatizar ações cujos 
parâmetros você acabou de mudar, 
quando você abrir um arquivo de 
dados.
• Liste as ações a serem 

realizadas quando este ou 
aquele arquivo de dados for 
aberto.

Dica: Procure em General, no Method 
Explorer.

a Na janela Method Explorer, selecione 
General > File Open Actions.

b Selecione Integrate and Extract Peak 
Spectra da lista Available actions. 

c Clique no botão Add, , para 
mover a ação selecionada para a lista 
Actions to be run. 
Você também pode clicar duas vezes 
sobre a ação selecionada para movê-la 
para a outra lista.

11 Teste as File Open Actions. • Clique no ícone Run File Open Actions 
Now  para executar ações no 
arquivo de dados. 

• Os cromatogramas e espectros não 
são sobrescritos. Novos 
cromatogramas e espectros são 
adicionados.

Figura 48 A seção General > File Open Actions no Method Editor

12 Grave o método. • Clique no ícone Save Method na janela 
do Method Editor.

Tarefa 18. Defina e execute o método de análise qualitativa usando o fluxo de trabalho Geral.

Etapas Instruções Detalhadas Comentários

Duas ações diferentes são parte 
da lista de Ações a serem 
executadas. A primeira ação é 
extrair os cromatogramas 
definidos. Em seguida, o 
cromatograma será integrado e 
seus picos, extraídos.
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13 Defina o método para automatizar 
as ações quando o método for 
executado a partir de uma lista de 
trabalho.
• Liste as ações a serem 

realizadas quando este ou 
aquele arquivo de dados for 
aberto.

Dica: Olhe sob a Worklist Automation 
na janela do Method Explorer.

a Na janela Method Explorer, selecione 
Worklist Automation > Worklist 
Actions.

b Remova Generate Analysis Report da 
lista Actions to be run.

14 Teste as Worklist Actions. • Clique no ícone Run Worklist Actions 
Now  para executar ações no 
arquivo de dados. 

• Os cromatogramas e espectros não 
são sobrescritos. Novos 
cromatogramas e espectros são 
adicionados.

Figura 49 A Worklist Automation > Worklist Actions no Method Editor

15 Salve o método e feche o arquivo 
de dados sem resultados do 
processo de salvar.

a Clique no ícone Save Method no 
Method Editor.

b Clique File > Close Data File e clique 
No quando for perguntado se os 
resultados devem ser salvos.

Tarefa 18. Defina e execute o método de análise qualitativa usando o fluxo de trabalho Geral.

Etapas Instruções Detalhadas Comentários

Duas listas diferentes de ações 
são incluídas em um método. A 
primeira lista de ações (File Open 
Actions) pode ser executada 
quando um arquivo de dados é 
aberto. A segunda lista de ações 
(Worklist Actions) é executada 
quando o método é executado.
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Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening
Tarefa 19. Defina e execute um método utilizando o fluxo de 
trabalho GC/Q-TOF Compound Screening

Nesta tarefa, você pode definir um método de análise qualitativa que contenha 
uma lista de ações de análise a serem rodadas em uma ordem específica. Estas 
incluem a extração e integração de cromatogramas, extração de espectros, 
busca em uma biblioteca por espectros de pico, geração de fórmulas para 
espectros e impressão de relatório de análise.

Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening.

Etapas Instruções Detalhadas Comentários

1 Abra o TIC para o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique sobre o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d na 
pasta de arquivo de dados GC.

c Limpe a caixa de seleção Load result 
data e clique em Open.

2 Configure a interface do usuário 
para que funcione com os dados 
do CG.

• Siga as instruções apresentadas em 
“Tarefa 2. Configurar Interface de 
Usuário para dados GC/MS” na 
página 13.

• Para este exemplo, selecione o 
fluxo de trabalho do GC/Q-TOF 
Compound Screening.

3 Certifique-se de que um TIC foi 
extraído. 

a Na janela Method Explorer, selecione 
Chromatogram.

b Clique na seção Define 
Chromatograms.

c Na janela Method Editor, verifique se o 
cromatograma na seção Defined 
chromatograms é um TIC. Se não for, 
selecione TIC como Type. Clique no 
botão Change.

•
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Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening
4 Revise parâmetros para o 
algoritmo Find by Chromatogram 
Deconvolution.

a Clique na seção GC/Q-TOF Compound 
Screening > Find by Chromatogram 
Deconvolution na janela Method 
Explorer.

b Clique na aba Mass Filter.
c Defina o valor Absolute height a 
13000.

d Clique na aba Results.
e Clique no botão Highlight all 

compounds.
f Reveja os resultados em cada aba.

• Procure nas seções pelo fluxo de 
trabalho GC/Q-TOF Compound 
Screening.

• Observe as seis seções neste fluxo 
de trabalho. Todas as seções são 
réplicas de seções que já são parte 
do explorador de método.

• Observe que os triângulos azuis 
aparecem em outras seções do 
Method Explorer. Isto indica que os 
mesmos valores de parâmetros 
foram alterados em outro lugar 
também.

5 Revise parâmetros para o 
algoritmo Library Search.

a Clique na seção GC/Q-TOF Compound 
Screening > Identify by library 
search na janela Method Explorer.

b Clique sobre o botão Add Library. 
Selecione uma biblioteca e clique em 
Open.

c (opcional) Clique no botão Remove 
Library para remover uma biblioteca, 
se você não quiser usá-la.

d Reveja os parâmetros em cada aba.

• Ou a demo.l library ou a NIST08.l 
(ou outra versão da biblioteca NIST) 
está instalada na pasta 
\MassHunter\Library.

6 Salve o método como 
iii_GCexercise2, onde “iii” são 
suas iniciais.

a No menu superior, clique em Method 
> Save As.

b Digite iii_GCexercise2.
c Clique no botão Salvar.

Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening.

Etapas Instruções Detalhadas Comentários
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Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening
7 Defina um método para 
automatizar as ações quando um 
arquivo de dados for aberto.
• Liste as ações a serem 

realizadas quando este ou 
aquele arquivo de dados for 
aberto.

Dica: Olhe sob General na janela 
Method Explorer.

a Na janela Method Explorer, selecione 
General > File Open Actions.

b Remova Generate Analysis Report da 
lista Actions to be run.

c Remova Integrate and Extract Peak 
Spectra.

d Remova todas as outras ações da lista.
e Adicione Extract Defined 

Chromatograms.
f Adicione Find Compounds by 

Chromatographic Deconvolution.
g Adicione Search Spectral Library for 

Compound.

8 Teste as File Open Actions. • Clique no ícone Run ‘File Open’ 
Actions Now  para executar as 
ações a partir do arquivo de dados. 

• Os cromatogramas e espectros não 
são sobrescritos. Novos 
cromatogramas e espectros são 
adicionados.

Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening.

Etapas Instruções Detalhadas Comentários
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Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening
Figura 50 Resultados das ações da lista de trabalho em execução nos dados do GC/Q-TOF.

9 Salve o método como 
iii_GCexercise2, onde “iii” são 
suas iniciais.

a No menu, clique em Method > Save 
As.

b Digite iii_GCexercise2.
c Clique em Save.

• Se este método estiver rodando 
durante uma lista de trabalho de 
Aquisição de Dados, então as 
Worklist Actions nesta aba são 
executadas em uma ordem dada.

10 Feche o arquivo de dados sem 
salvar os resultados.

a Clique em File > Close Data File.
b Clique em No quando solicitado se os 

resultados devem ser salvos.

Tarefa 19. Defina e execute um método utilizando o fluxo de trabalho GC/Q-TOF Compound Screening.

Etapas Instruções Detalhadas Comentários
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Tarefa 20. Exporte um arquivo CEF
Tarefa 20. Exporte um arquivo CEF

Você pode exportar um arquivo CEF contendo informações do composto. Este 
arquivo CEF pode ser importado para outros programas, como o MassHunter 
Quantitative Analysis ou o Mass Profiler Professional. Você tamb´me pode 
importar compostos que foram exportados em um arquivo CEF.

Tarefa 20. Exporte um arquivo CEF

Etapas Instruções Detalhadas Comentários

1 Abra o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d 
e execute as ações File Open para 
o método iii_GCexercise2.m, que 
foi criado em “Tarefa 19. Defina e 
execute um método utilizando o 
fluxo de trabalho GC/Q-TOF 
Compound Screening” na 
página 79.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique sobre o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d na 
pasta de arquivo de dados GC.

c Limpe a caixa de marcação Load result 
data.

d Marque a caixa de marcação Run ‘File 
Open’ actions from selected method.

e Clique no botão Use current method e, 
em seguida, clique em Open.

• Se você finalizou“Tarefa 19. Defina 
e execute um método utilizando o 
fluxo de trabalho GC/Q-TOF 
Compound Screening” na 
página 79, o método atual deve ser 
iii_GCexercise2.m. Este método 
está configurado para executar o 
algoritmo Find Compounds by 
Chromatogram Deconvolution e, em 
seguida, rodar o algoritmo Search 
Library em cada composto.

2 Exporte um arquivo CEF. a Para exportar o arquivo de modo 
interativo, clique em File > Export > 
as CEF.

b Clique no botão All results.
c Selecione o local de exportação do 

arquivo.
d Clique em OK.

• Um arquivo CEF é usado para 
exportar compostos. 
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Tarefa 20. Exporte um arquivo CEF
Figura 51 Caixa de diálogo Export CEF Options.

Tarefa 20. Exporte um arquivo CEF (cont.)

Etapas Instruções Detalhadas Comentários
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Tarefa 21. Imprima um relatório de análise
Tarefa 21. Imprima um relatório de análise

Quano você quiser imprimir um relatório de análise após realizar qualquer 
uma das tarefas neste exercício ou no seguinte, utilize as seguintes instruções. 

Um relatório de análise pode conter os resultados da extração e integração de 
cromatograamas, extração de espectros, busca de compstoso, busca em um 
banco de dados por espectros de pico ou geração de fórmulas a partir de 
espectros de pico. 

Tarefa 21. Imprima um relatório de análise

Etapas Instruções Detalhadas Comentários

1 Se o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d 
não for carregado, então abra este 
arquivo de dados e rode a ação File 
Open para o método 
iii_GCexercise2.m, que foi criado 
em “Tarefa 19. Defina e execute um 
método utilizando o fluxo de 
trabalho GC/Q-TOF Compound 
Screening” na página 79.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique sobre o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d na 
pasta de arquivo de dados GC.

c Limpe a caixa de marcação Load result 
data.

d Marque a caixa de marcação Run ‘File 
Open’ actions from selected method.

e Clique no botão Use current method e, 
em seguida, clique em Open.

• Se você finalizou“Tarefa 19. Defina 
e execute um método utilizando o 
fluxo de trabalho GC/Q-TOF 
Compound Screening” na 
página 79, o método atual deve ser 
iii_GCexercise2.m. Este método 
está configurado para executar o 
algoritmo Find Compounds by 
Chromatogram Deconvolution e, em 
seguida, rodar o algoritmo Search 
Library em cada composto.

2 Altere as seleções do relatório de 
análise no método:
• Marque as caixas de marcação 

para os cromatogramas, 
espectros ou tabelas que você 
gostaria de imprimir.

• Limpe as caixas de marcação 
para os cromatogramas, 
espectros ou tabelas que você 
gostaria de imprimir.

a Na janela Method Explorer, selecione 
Reports > Analysis Report.

b Marque as caixas de marcação para 
quaisquer seleções adicionais que 
você queira imprimir.

c Limpe qualquer cromatograma ou 
escolha de espectros que você não 
queira imprimir.

• O relatório Analysis contém as 
informações que você marcou nesta 
seção. 

• Se alguns resultados não estiverem 
disponíveis, escolha resultados não 
incluídos, mesmo que estes 
resultados sejam marcados na 
seção. Por exemplo, se você não 
integrou o cromatograma, então a 
tabela de pico não será incluída.
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3 Utilize fluxos de trabalho, exporte e imprima
Tarefa 21. Imprima um relatório de análise
Figura 52 A seção Analysis Report, no Method Explorer e Method Editor

3 Imprima o relatório. a Você pode imprimir interativamente o 
relatório de múltiplas maneiras.
• A partir do menu principal, clique em 

File > Print > Analysis Report.
• A partir da barra de ferramentas 

principal, clique no ícone Printer.
• Clique no ícone Print Analysis 

Report,  na barra de 
ferramentas Method Editor quando 
a seção Relatório de Análise for 
selecionada.

• Clique com o botão direito sobre a 
seção Relatório de Análise, no 
Method Editor, em seguida, clique 
em Print Analysis Report.

• A partir do menu de atalhos do 
arquivo de dados, em Data 
Navigator, clique em Analysis 
Report.

b Clique em Report contents.
c Marque a caixa de marcação Print 

report e selecione uma impressora.
d Marque a caixa de marcação Print 

preview.
e Clique sobre o botão OK.

• O ícone Run , na barra de 
ferramentas do Method Editor, às 
vezes permite que você escolha 
uma ação a partir de um conjunto 
de ações possíveis. Por exemplo, se 
você alterar para a seção Reports > 
Common Reporting Options da 
janela Method Editor, quatro 
diferentes ações serão possíveis 
quando você clicar sobre o ícone 
Executar. Se você clicar sobre a 
seta, uma lista de ações possíveis 
será exibida, e você pode escolher 
que ação executar. Escolher uma 
ação diferente da lista, modifica a 
ação padrão. Se você simplesmente 
clicar sobre o botão Run, a ação 
padrão atual será realizada.

Tarefa 21. Imprima um relatório de análise (cont.)

Etapas Instruções Detalhadas Comentários

Por definição, a janela Method Editor 
estará flutuando. Ela estará visível 
como uma janela separada do 
restante do programa Qualitative 
Analysis. Para imobilizar a janela, 
clique com o botão direito sobre ela e, 
em seguida, clique em Floating. Você 
também pode clicar duas vezes sobre 
a barra de título para imobilizar a 
janela.
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Tarefa 21. Imprima um relatório de análise
Figura 53 Caixa de diálogo Print Analysis Report

f Rever o relatório.
g Clique sobre o ícone Close Print 

Preview na barra de ferramentas.

Figura 54 Imprima a janela de pré-visualização com o relatório de análise

Tarefa 21. Imprima um relatório de análise (cont.)

Etapas Instruções Detalhadas Comentários
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Tarefa 22. Imprima um relatório de composto
Tarefa 22. Imprima um relatório de composto

Quando você quer imprimir um relatório de compsoto, utilize estas instruções.

Tarefa 22. Imprima um relatório de composto

Etapa Instruções Detalhadas Comentários

1 Se o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d 
não for carregado, então abra este 
arquivo de dados e rode a ação File 
Open para o método 
iii_GCexercise2.m, que foi criado 
em “Tarefa 19. Defina e execute um 
método utilizando o fluxo de 
trabalho GC/Q-TOF Compound 
Screening” na página 79.

a Se o programa não estiver aberto, 
clique duas vezes no ícone Mass 
Hunter Qualitative Analysis. Do 
contrário, clique em File > Open Data 
File.

b Clique sobre o arquivo de dados 
MSD_mix_4stds_DG_spl200_03.d na 
pasta de arquivo de dados GC.

c Limpe a caixa de marcação Load result 
data.

d Marque a caixa de marcação Run ‘File 
Open’ actions from selected method.

e Clique no botão Use current method e, 
em seguida, clique em Open.

• Se você finalizou“Tarefa 19. Defina 
e execute um método utilizando o 
fluxo de trabalho GC/Q-TOF 
Compound Screening” na 
página 79, o método atual deve ser 
iii_GCexercise2.m. Este método 
está configurado para executar o 
algoritmo Find Compounds by 
Chromatogram Deconvolution e, em 
seguida, rodar o algoritmo Search 
Library em cada composto.

2 Modifique algumas das seleções 
no método para relatórios de 
compostos:
• Desligue a visualização do 

espectro MS com zoom em picos 
especiais.

• Desligue as opções do MS/MS 
no relatório.

a Em Method Explorer, clique sobre 
Reports > Compound Report.

b Limpe a caixa de marcação Show MS 
spectrum.

c Limpe a caixa de marcação Show 
MS/MS spectrum.

d Limpe a caixa de marcação Show 
MS/MS peak table.

• Estas caixas de marcação permitem 
que você especifique quais 
informações incluir em um relatório 
quando ele estiver disponível. Se a 
informação não estiver disponível, 
a seção será ignorada 
automaticamente. Por exemplo, os 
resultados MS/MS nunca são 
incluídas quando os arquivos de 
dados apenas tem dados MS.
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Tarefa 22. Imprima um relatório de composto
Figura 55 A seção Compound Report no Method Editor

3 (opcional) Escolha uma exibição de 
relatório de composto diferente.

a Na janela Method Explorer, selecione 
Reports > Common Reporting 
Options.

b Selecione CompoundReport
WithIdentificationHits.xlsx como o 
template de relatório de Composto.

• Vários diferentes templates de 
relatórios são incluídos no 
software.

• Você pode customizar o template 
usando o Excel ou a extensão 
Report Designer.

Figura 56 Opções de Relatório Comuns no Editor de Métod

Tarefa 22. Imprima um relatório de composto

Etapa Instruções Detalhadas Comentários

A caixa de marcação dos 
cromatogramas de composto Overlay 
devem ser limpas para os dados 
GC/Q-TOF.

Você pode usar o Excel e a 
extensão Report Designer para 
customizar qualquer template 
que tenha a extensão XLTX. Você 
não pode customizar o relatório 
de método de aquisição.
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Tarefa 22. Imprima um relatório de composto
4 Imprima o relatório. a Clique em File > Print > Compound 
Report ou clique na seta do ícone Print 
Analysis Report  e clique em Print 
Compound Report para imprimir o 
relatório de composto.

b Marque a caixa de marcação Print 
preview.

c Clique em OK. Examine o relatório.
d Clique no ícone Close Print Preview.

• Na caixa de diálogo Print Compound 
Report, você pode selecionar uma 
impressora diferente, escolher 
salvar o relatório como um arquivo 
PDF ou Excel, selecionar se quer 
imprimir todos os resultados ou 
apenas os destacados e se quer ou 
não combinar diferentes arquivos 
de dados em um único relatório.

• Consulte a Ajuda online ou o DVD 
de Treinamento em Design de 
RElatórios para informações 
adicionais.

Figura 57 Imprima a janela de pré-visualização com o relatório de composto.

5 Feche o arquivo de dados sem 
salvar os resultados.

a Clique em File > Close Data File.
b Clique em No quando lhe for perguntado 

se você gostaria de salvar os resultados.

Tarefa 22. Imprima um relatório de composto

Etapa Instruções Detalhadas Comentários
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Trabalhe com Janelas
Trabalhe com Janelas

Quando você abre o programa Análise Qualitativa, você vê quatro janelas na 
exibição padrão: Data Navigator, Method Explorer, Chromatogram Results e 
MS Spectrum Results. Você pode alterar entre Navigator View e Compound Details 
View.

Você pode trazer até dezessete novas janelas para a Navigation View utilizando 
o menu View: 

• Method Editor - permite que você edite parâmetros de método separados 
em diferentes abas

• Spectrum Preview - permite que você rastreie rapidamente os espectros em 
um arquivo de dados

• MS Spectrum Results - exibe o MS e os espectros de MS/MS

• Difference Results - exibe os resultados de diferença após uma busca na 
biblioteca

• Deconvolution Results - exibe os espectros de deconvolução

• Deconvolution Mirror Plot - exibe dois espectros em deconvolução em uma 
imagem de reprodução

• UV Spectrum Results - exibe os espectros UV - apenas disponível para 
dados de LC/MS.

• Integration Peak List - exibe os resultados da integração em uma tabela

• MS Spectrum Peak List 1 - exibe a tabela de picos para o primeiro espectro 
selecionado

• MS Spectrum Peak List 2 - exibe a tabela de picos para o segundo espectro 
selecionado

• MS Actuals - exibe informações de aquisição para o espectro destacado

• Compound List - exibe os compostos encontrados utilizando-se um dos 
algoritmos de Encontrar Compostos

• Compound Identification Results - exibe a informação de identificação para 
o composto selecionado

• Spectrum Identification Results - exibe a informação de identificação para 
o espectro selecionado

• MS/MS Formula Details - exibe uma tabela que contém possíveis fórmulas 
calculadas para fragmentos vistos em um espectro MS/MS
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Trabalhe com Janelas
• Structure Viewer - exibe a estrutura associada com o composto atual ou 
espectro

• Sample Information - exibe informações sobre o arquivo de dados 
destacado

• Sequence Editor - sempre permite que você edite uma sequência de método

Você também pode exibir três janelas de ferramentas que são exibidas quando 
você começa utilizando a ferramenta associada:

• Formula Calculator

• Mass Calculator

• Recalibrate

Window Icons na Barra de Ferramentas Principal

Você abre e fecha as janelas com estes ícones na barra de ferramentas principal. 
Ícones adicionais estarão disponíveis quando o software MassHunter BioConfirm 
estiver instalado. Comandos no menu de Visualização também podem ser usados 
para abrir estas janelas.
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MS Spectrum
Results

Data Navigator

Spectrum 
Preview

Chromatogram Results

Method Editor

Method Explorer

Integration Peak List

Spectrum 
Identification 
Results

MS Spectrum 
Peak List 1

Compound List

MS Spectrum 
Peak List 2

MS Actuals

Compound 
Identification 
Results

Sequence 
Editor

Deconvolution
Results

UV Spectrum 
Results

MS/MS 
Formula 
Details

Difference 
Results

Structure 
Viewer

Sample 
Information

Deconvolution
Mirror Plot
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Trabalhe com os dados de resultado em Data Navigator
Trabalhe com os dados de resultado em Data Navigator

Janela e ferramentas em Data Navigator

O Data Navigator organiza todos os resultados de extração e de seleção de espectro 
tanto por arquivo de dados quanto por tipo de dados.

 

Quando ativado (padrão), destacar um 
cromatograma no Navegador de Dados também 
destaca os espectros correspondentes. Os 
resultados do cromatograma e gráfico de 
espectros correspondentes também são 
destacados. Linked Navigation apenas funciona 
se você utilizou o item do menu Extract Peak 
Spectra no Menu Chromatograms ou se você 
rodou algum dos algoritmos de Compounds.

Single check mark – Marca as caixas de 
marcação de todos os dados destacados.

Dual check marks, one gray – Marca as caixas de 
marcação dos dados destacados e limpa as 
demais caixas de marcação.

Dual check marks – Marca todas as caixas de 
marcação.

Os cromatogramas e espectros são exibidos 
quando as caixas de marcação são marcadas.

Check Mark Tools

Linked Navigation Icon
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Realize operações do cromatograma

Você pode realizar as seguintes operações em todo o cromatograma ou em uma 
região selecionada do cromatograma utilizando os itens do menu:

Action Item do Menu

Altere a classificação de pico no 
cromatograma

Configuration > Chromatogram Display Options

Extraia um cromatograma Chromatograms > Extract Chromatograms

Extraia cromatogramas definidos Chromatograms > Extract Defined Chromatograms

Integre o cromatograma Chromatograms > Integrate Chromatogram

Integre e extraia o espectro do pico Chromatograms > Integrate and Extract Peak Spectra

Integre e realize a deconvolução do 
espectro do pico

Chromatograms > Integrate and Deconvolute Peak 
Spectra

Suavize o cromatograma Chromatograms > Smooth Chromatogram

Subtraia qualquer cromatograma Chromatograms > Subtract Any Chromatogram

Calcule a relação sinal-ruído Chromatograms > Calculate Signal-to-Noise

Encontre compostos a partir dos dados do 
MS/MS automático

Find > Find Compounds by Auto MS/MS

Encontre compostos a partir dos dados do 
MS/MS-alvo

Find > Find Compounds by Targeted MS/MS

Encontre compostos para os dados do 
MS(1)

Find > Find Compounds by Molecular Feature

Encontre compostos para os dados do 
CG/MS

Find > Find Compounds by Chromatogram 
Deconvolution

Encontrar compostos por dados do MRM Find > Find Compounds by MRM

Encontrar compostos por resultados de 
integração

Find > Find Compounds by Integration

Encontrar compostos que atendam a 
fórmulas específicas

Find > Find Compounds by Formula
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Selecionar operações de amplitude a partir do menu de atalhos

Quando você tiver selecionado a amplitude cromatográfica, você poderá também 
extrair um espectro e extrair um espectro para o plano de fundo, além de realizar 
as operações mencionadas acima e de outras não mencionadas.

1 Para acessar essas operações, clique na ferramenta Range Select ( ) na barra 
de ferramentas de Chromatograms Results. 

2 Clique no ponto em que você quer que a amplitude seja iniciada, arraste o 
cursor sobre uma amplitude e, em seguida, solte o botão do mouse.

3 Clique com o botão direito sobre qualquer cromatograma e clique na 
operação a partir do menu de atalhos.

Salve os resultados no(s) arquivo(s) de dados

• Clique no ícone Save ( ), ou clique em File > Save Results.

Quando você sair do programa, ele também lhe perguntará se você qer salvar os 
resultados no arquivo de dados, a não ser que você tenha desativado esta 
função (você desativa a função na caixa de diálogo das Opções da Caixa de 
Mensagens).

Realize operações em um espectro MS ou MS/MS

Você pode realizar as seguintes operações em um espectro MS ou MS/MS ou em 
uma região selecionada de um espectro MS ou MS/MS utilizando os seguintes itens 
do menu:

Action Item do Menu

Visualize m/z, abundância, estado de 
carga e outras informações sobre picos em 
um espectro

View > MS Spectrum Peak List 1

Modifique as classificações de pico 
espectral

Configuration > MS and MS/MS Spectra Display 
Options

Subtraia o espectro do plano de fundo Spectra > Subtract Background Spectrum

Subtraia qualquer espectro Spectra > Subtract Any Spectrum (and then click 
another spectrum)

Adicione dois espectros juntos Spectra > Add Any Spectrum (and then click another 
spectrum)
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Trabalhe com dados visuais cromatográficos

Chromatogram Results Window

Busque em um banco de dados por 
entradas que correspondam a massas 
específicas em um espectro

Spectra > Search Database for Spectrum Peaks

Gere fórmulas para as massas na 
amplitude selecionada em um espectro 

Spectra > Generate Formulas from Spectrum Peaks 
(when a range is selected in the MS spectrum)

Realize a deconvolução utilizando o 
algoritmo Resolved Isotope

Spectra > Deconvolute (Resolved Isotope)

Busque na Biblioteca Identify > Search Library for Spectra ou
Spectra > Search Library for Spectra

Action Item do Menu
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Chromatogram Results Tools

Trabalhe com dados visuais espectrais

Janela de Resultados de Espectro MS

Ferramentas de Zoom 
em ordem

Ferramentas Selecionadas em 
ordem Range Select – Quando On, você pode estipular uma 

amplitude para o cromatograma, por meio da qual você 
pode realizar ações.

Peak Select – Quando On, você pode selecionar um 
espectro de um pico integrado no ápice.

Manual Integration – Quando On, você pode integrar 
interativamente.

Walk Chromatogram – Quando On, você pode visualizar 
espectros individuais enquanto clica em cada ponto ou 
usar as teclas seta-esquerda ou seta-direita do teclado.

Annotation – Quando On, você pode adicionar uma 
imagem e anotações em texto aos cromatogramas.

Autoescala para Eixo-X e Eixo-Y

Autoescala para Eixo-X

Autoescala para Eixo-Y

Diminuir zoom

Autoescala para Eixo-Y com Zoom

Modo de Eixo-Y Conectado

Uma dessas ferramentas 
sempre estará selecionada.
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Ferramentas de Resultados de Espectro MS

Fluxos de Trabalho

Os fluxos de trabalho ajudam você a customizar a interface de usuário para 
seu aplicativo. Cada fluxo de trabalho carrega um método diferente que tem 
parâmetros que são apropriados para aquele fluxo de trabalho. Além disso, 
cada fluxo de trabalho carrega um layout diferente; estes layouts incluem a 
customização das colunas exibidas em cada tabela. Por último, quatro dos 
layouts também adicionam uma seção de editor de método especial que 
contém cópias das seleções do editor de método que são importantes para 
aquele fluxo de trabalho. Agrupar as configurações que são usadas em um 
fluxo de trabalho específico faz com que seja mais fácil que você customize seu 
método.

Vários fluxos de trabalhos distintos estão disponíveis no programa de Análise 
Qualitativa. São eles:

• Geral

Ferramentas de Zoom 
em ordem

Ferramentas 
Selecionadas em ordem

Range Select – Quando On, você pode estipular uma 
amplitude para o cromatograma, por meio da qual você 
pode realizar ações.

Annotation – Quando On, você pode adicionar uma 
imagem e anotações em texto aos cromatogramas.

Calipers – Quando On, você pode adicionar um compasso 
de Massa Delta ao espectro selecionado. Na janela 
Deconvolution Results, você pode adicionar um compasso 
de Aminoácido ou um compasso de Modificações. 
Consulte a Ajuda online para mais informações.

Autoescala para Eixo-X e Eixo-Y

Autoescala para Eixo-X

Autoescala para Eixo-Y

Diminuir zoom

Autoescala para Eixo-Y com Zoom

Modo de Eixo-Y Conectado

Para limpar uma 
seleção de ferramenta, 
clique em outra 
ferramenta ou ícone.
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• BioConfirm - Estes fluxos de trabalho só estão disponíveis se o software 
BioConfirm for instalado e marcado na caixa de diálogo User Interface 
Configuration. BioConfirm conta com vários fluxos de trabalho possíveis, 
dependendo do tipo de análise que você gostaria de fazer. BioConfirm é 
usado com arquivos de dados LC/MS.

• Chromatogram Peak Survey

• Formula Confirmation e Sample Purity

• MS Target Compound Screening

• Rastreamento de Composto do CG/Q-TOF

Se você está trabalhando com dados do CG/MS, você pode selecionar o fluxo 
de trabalho General ou o fluxo de trabalho GC/Q-TOF Compound Screening. 
Se você está trabalhando com dados do LC/MS, você pode selecionar qualquer 
fluxo de trabalho exceto o GC Q-TOF Compound Screening.

Specific Method

Cada fluxo de trabalho carrega um método padrão específico com 
configurações apropriadas para aquele fluxo de trabalho. Por exemplo, se você 
alternar para um dos fluxos de trabalho BioConfirm, o Target data type para 
o algoritmo Find Compounds by Molecular Feature é definido como Large 
molecules (proteins, oligos). Esta configuração é apropriada para o fluxo de 
trabalho BioConfirm, mas não, por padrão, para outros fluxos de trabalho.
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Layout Específico:

Além disso, cada fluxo de trabalho carrega um layout específico. Um layout 
consiste no seguinte:

• Posição e tamanho de cada janela

• Quais janelas possuem abas

• Quais janelas estão flutuando

• Qual janela com aba está no topo

• Quais janelas são visíveis por definição

• Se a barra de status está visível

Para cada janela de gráfico (a janela de Resultados do Cromatograma, a janela 
de Previsão do Espetro, a janela de Resultados do Espectro MS, a janela de 
Deconvolução e a janela de Resultados UV), as seguintes informações são 
salvas:

• Se os gráficos estão sobrepostos ou não

• Se a Autoescala do Eixo-Y durante o modo zoom está ligada ou não

• Se a Autoescala do Eixo-Y está ligada ou não

Para cada janela de tabela, as seguintes informações são salvas:

• Quais colunas estão visíveis

• A ordem das colunas

• A largura de cada coluna

• Qualquer filtro que tenha sido adicionado à tabela (apenas disponível para 
a tabela de Lista de Compostos, a tabela e Resultados de Identificação de 
Compostos e a janela de Resultados de Identificação de Espectro).

Seção específica do Explorador de Método e do Editor de Método

Utilizando o Editor de Método com o fluxo de trabalho Geral, você pode alterar 
quase todos os parâmetros no Método. 

Cada um dos outro quatro fluxo de trabalhos altera as seções disponíveis no 
Explorador de Método. Cada seção nova contém apenas as abas do Editor de 
Método e seções que são úteis no fluxo de trabalho. Alterar um parâmetro na 
seção de fluxo de trabalho também altera o parâmetro na seção 
correspondente das seções de Editor de Método gerais.
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Duas abas não são repetidas nas seções do Editor de Método gerais. A seção 
Identificação de Pico de Espectro >do Fluxo de Trabalho da Pesquisa de 
Pico do Cromatograma e as abas Fluxo de Trabalho da Pesquisa de Pico do 
Cromatograma> Extração do Cromatograma > Cromatogramas estão 
incluídas apenas no fluxo de trabalho da Pesquisa de Pico do Cromatograma. 
Estas seções afetam apenas o algoritmo de Pesquisa de Pico do 
Cromatograma. Este algoritmo é usado apenas neste fluxo de trabalho, e na 
ação Pesquisa de Pico do Cromatograma sem Relatório, bem como na ação 
Pesquisa de Pico do Cromatograma com Relatório de Análise.

Métodos de fluxo de trabalho e layouts

Métodos-padrão adicionais e layouts são oferecidos para cada fluxo de 
trabalho: 

Fluxo de Trabalho Método Layout Seção do Editor de 
Método

Geral default.m Default.xml Nenhuma

Proteína Intacta 
BioConfirm

BioConfirm
IntactProtein-
Default.m

BioConfirm-
IntactProtein-
MaximumEntropy-
Default.xml

BioConfirm Workflow

BioConfirm High 
Mass Intact Protein

BioConfirm
IntactProtein
HighMass
Default.m

BioConfirm
IntactProtein
LMFE.xml

BioConfirm Workflow

BioConfirm Small 
Oligonucleotides

BioConfirmOligo
nucleotideSmall.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Large 
Oligonucleotides

BioConfirmOligo
nucleotideLarge-
Default.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Protein 
Digest

BioConfirmProtein
Digest-Default.m

BioConfirm
ProteinDigest.xml

BioConfirm Workflow

BioConfirm 
Synthetic Peptide

BioConfirmSynthetic
Peptide-Default.m

BioConfirm
SyntheticPeptide.xml

BioConfirm Workflow

Chromatogram Peak 
Survey

ChromPeakSurvey-
Default.m

Default.xml Chromatogram Peak 
Survey Workflow
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Fluxos de Trabalho
Formula 
Confirmation e 
Sample Purity

SamplePurity-
Default.m

SamplePurity-
Default.xml

Confirmação de Fórmula e 
Fluxo de Trabalho de 
Pureza da Amostra

MS Target 
Compound 
Screening

Screening-Default.m Screening-Default.xml Fluxo de Trabalho do 
Rastreamento do 
Composto-alvo do MS

Rastreamento de 
Composto Q-TOF do 
CG

GC_Q-TOF.m QTOFData.xml Rastreamento de 
Composto do CG/Q-TOF

Fluxo de Trabalho Método Layout Seção do Editor de 
Método
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Customize uma exibição de relatório
Customize uma exibição de relatório

Por favor, consulte a Ajuda online para o Aplicativo de Design de Relatórios do 
MassHunter, o Guia de Familiarização com Design de Relatórios ou o DVD de 
Treinamento em Relatórios para informações detalhadas sobre exibições de 
relatório. Os seguintes passos dão a você noções sobre o que significa 
customizar uma exibição.

1 Vá até a pasta que contém as exibições de relatório. Por padrão, a pasta é: 
\MassHunter\Report Templates\Qual\B.05.00\en-US\Letter. Você pode selecionar 
uma pasta diferente no Explorador de Método, na aba Exibições do > Opções 
Comuns de Relatórios>.

2 Faça uma cópia da exibição que você gostaria de modificar. Clique com o botão 
direito sobre a cópia e clique em Propriedades. Se necessário, limpe a caixa de 
marcação Somente Leitura. Em seguida, clique com o botão direito sobre a 
cópia e clique em Abrir no menu de atalhos.

Abrir a exibição deste modo permite que o Excel saiba que este arquivo é um 
arquivo de exibição. Quando a exibição estiver aberta, você pode modificar os 
cabeçalhos e notas de rodapé e adicionar, remover ou mover colunas de 
parâmetros. Consulte a Ajuda online para mais informações. Todas as exibições 
de Análise Qualitativa são marcadas como Somente Leitura. Você pode mudar 
esta propriedade antes de editar a exibição.
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Customize uma exibição de relatório
Muitas exibições são instaladas com o programa de Análise Qualitativa. 
Consulte a Ajuda online da Análise Qualitativa para mais informações 
sobre o conteúdo de cada exiibção de relatório.

3 Faça as modificações que você quer fazer.

Para mais informações sobre como alterar uma exibição, consulte ou a 
Ajuda online do aplicativo de Design de Relatórios do MassHunter, ou o 
DVD de Treinamento de Relatório do MassHunter Agilent.

4 Para salvar uma exibição nova, clique em Save ou clique em Save As > Other 
Formats no botão do Microsoft Office. 

5 Digite um nome de indentificação e clique em Save.
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